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Preface

Welcome to the EMS Regics User’s Manual. The purpose of the EMS Regics User’s Manual 
is to answer your questions and guide you through the procedures necessary to use EMS 
Regics efficiently and effectively.

Using the manual
You will find the EMS Regics User’s Manual easy to use. You can simply look up the topic 
that you need in the table of contents or the index. Later, in this Preface, you will find a brief 
discussion of each chapter to further assist you in locating the information that you need.

Special information about the manual
The EMS Regics User’s Manual has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you print the document, for best results, it is recommended that you 
print it on a duplex printer; however, single-sided printing will also work. If you view the 
document online, a standard set of bookmarks appears in a frame on the left side of the 
document window for navigation through the document. For better viewing, decrease the 
size of the bookmark frame and use the magnification box to increase the magnification of 
the document to your viewing preference.

Conventions used in the manual 
The EMS Regics User’s Manual uses the following conventions:

• Two types of users can work with the products (online registration forms and surveys) 
that are produced in EMS Regics—a registrant and a respondent. For brevity, the 
collective term “participant” is used when an EMS Regics definition or function is 
applicable to both event registrants and survey respondents. For definitions or functions 
that are user-specific, the correct individual term, “registrant” or “respondent,” is used. 

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Group tab name>. Do 
not type the angle brackets when you specify the variable information.

If you do print the document using a single-sided printer, you might see a single 
blank page at the end of some chapters. This blank page has been added solely to 
ensure that the next chapter begins on an odd-numbered page. This blank page in 
no way indicates that your book is missing information.
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• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover and ending on the last page of the index.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries 
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual
The EMS Regics User’s Manual assumes that:

• You are familiar with a web-based application and basic web functions and navigational 
elements.

• If you are running EMS Regics in Internet Explorer 8, you have enabled the following 
setting: Tools -> Internet Options -> Security -> Custom Level -> Downloads -> 
Automatic prompting for file downloads. (Enabling this setting ensures that you can 
generate reports or export a file to a list.) 

Organization of the manual
In addition to this Preface, the EMS Regics User’s Manual contains the following chapters:

• Chapter 1, “Getting Started with EMS Regics,” on page 15 details the procedures for 
opening and logging in to EMS Regics. It also provides an overview of the major 
navigational elements in the application, including required fields and icons.

• Chapter 2, “Event Registration Form and Survey Creation,” on page 25 details the 
procedures for creating an online event registration form or a survey for your 
organization, and for managing participant information.

• Chapter 3, “Event Registration Form and Survey Management,” on page 67 details the 
procedures for managing an online event registration form or a survey for your 
organization, and for managing participant information.

• Chapter 4, “EMS Regics System Administration - Configuration,” on page 107 details the 
configuration functions that are available in EMS Regics, including configuring 
registrant/respondent fields, payment types, global emails, global confirmation messages, 
and secondary statuses.

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the table of contents.
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• Chapter 5, “EMS Regics System Administration - General Administration,” on page 131 
details the general administrative functions that are available in EMS Regics, including 
managing system parameters, your EMS Regics license, the Help text in your EMS 
Regics system, and searching for credit card transactions for event registrations.

• Chapter 6, “EMS Regics System Administration - Security,” on page 143 details the 
security functions that are available in EMS Regics, including managing users and 
groups.

• Chapter 7, “EMS Regics Reports,” on page 163 details how to generate both standard and 
custom EMS Regics reports.

• Appendix A, “EMS Regics System Parameters,” on page 181 details the system 
parameters (by area) that the EMS Regics administrator can configure.
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Chapter 1
Getting Started with EMS Regics

EMS Regics is online event registration software that provides event planners and organizers 
with data management and control of their events and attendees. The application also 
provides for the quick and easy creation of professional online surveys that can be 
standalone surveys, or that can be used in support of events. This chapter details the 
procedures for opening and logging in to EMS Regics. It also provides an overview of the 
major navigational elements in the application, including required fields and icons.

This chapter covers the following topics:

• “Opening and Logging in to EMS Regics” on page 16.

• “Required Fields and Using Icons to Enter Data” on page 19.

• “An EMS Regics Browser Page” on page 22.
EMS Regics User’s Manual 15
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Opening and Logging in to EMS Regics
EMS Regics is a web-based application that has two levels of users—Administrator and 
Standard—who can work with the application to create and manage event registration forms 
and surveys. The options that are available to you and the information that you can view after 
you log in to EMS Regics depend on your user classification and are detailed in the 
appropriate sections in this manual. 

To log in to EMS Regics

1. Open a web browser session.

2. In the address field, enter the URL (address) for your organization’s installation of EMS 
Regics.

The EMS Regics Home page opens.

Figure 1-1:  EMS Regics Home page

3. Under My Account, click Log In.

The EMS Regics Login page opens.

Figure 1-2:  EMS Regics Login page
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4. Enter your user ID (network ID or email address) and password, and then click Login.

The Dashboard opens. If you are an Administrator user, then you have full site privileges 
and you have full access to all of the event registrations forms and surveys that have 
been defined in your organization’s system. If you are a Standard user, then you have 
limited privileges and you have access to only specific event registration forms or 
surveys as specified by your EMS Regics administrator. 

Figure 1-3:  EMS Regics Dashboard

To change your account password

After you login to EMS Regics, you can manually change the password for your account.

1. On the Dashboard, click My Account > Change Password.

The Account Password page opens.

Figure 1-4:  Account Password page

  

For subsequent log ins, the User Id field is automatically populated with your user 
ID. If you have forgotten your password, then you can click the Reset Password 
link to have EMS Regics reset your password and email it to you. You also have 
the option of changing your password after you login. See “To change your 
account password” below.
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2. In the Old Password field, enter your current password. 

3. In the New Password field, enter your new password. 

4. In the Confirm Password field, enter your new password exactly as you entered it in the 
New Password field. 

5. Click Update.
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Required Fields and Using Icons to Enter Data
A required field is a field into which you must enter data before you can save an addition or 
modification in EMS Regics. A required field is denoted by a red asterisk to the right of it.

Figure 1-5:  Example of a required field

Many fields in EMS Regics, whether required or optional, have an icon next to them. For 
some fields with an icon next to them, the only available option is to click the icon to open a 
list from which you can select a value for the field. For other fields, you can click the icon 
next to the field, or you can manually enter data into the field.

Figure 1-6:  Example fields with icons on an EMS Regics page

Each icon is identified by a unique name in EMS Regics. If a procedure in the EMS Regics 
User’s Manual refers to an icon and you are not certain as to which icon the procedure is 
referring, then place your mouse pointer on the icon. The name of the icon is displayed in a 
tooltip.

Figure 1-7:  Viewing the name of an icon

Several icons—the Calendar picker icon, the Color Picker icon, and the Time Picker icon—
are used repeatedly in EMS Regics and these icons function the same way regardless of the 
page on which they are used.

Calendar Picker icon

For any date field in EMS Regics, you can manually enter the date in the field, or you can 
click the Calendar Picker icon to open the Calendar Tool from which you can select a date. If 
you manually enter a date in a date field, you can enter the date in any month/day/year 
format—mm/dd/yyyy, m/d/yy, and so on. The application always displays the date based on 
the language that is specified for your web browser and you cannot modify the format.

Figure 1-8:  Example of populated date fields

For a date field, you can click the Calendar Picker icon 
to open a calendar and select the date, or you can 
enter the date manually into the field,
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When you click the Calendar Picker icon, the Calendar Tool opens. This tool shows the 
current day’s date. You can use the scroll features on the tool to select dates within the 
current calendar year, or for previous or future years. 

Figure 1-9:  Calendar Tool

Color Picker icon

If you can specify a color for a selected item in EMS Regics, for example, a survey title, then 
a Color Picker icon is displayed next to the item. You can manually enter an RGB or HEX 
value for the color in the field, or you can click the Color Picker icon to open the Color 
Picker dialog box. You can select an RGB color on the RGB tab, you can select a named 
color on the Named Color tab, or you can define a custom color on the Color slider tab. After 
you use the Color Picker dialog box to select or define a color, the dialog box closes 
automatically and the Color field is populated with the RGB or HEX value for the selected 
color.

Figure 1-10: Color Picker dialog box

  

Scroll backwards or 
forwards by month 
for a selected year.

Select a different 
month for a selected 
year.

Select a different year.

Click the Color Picker icon to open the 
Color Picker dialog box and select an RGB 
color or a named color, or define a custom 
color for an item in EMS Regics. 
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Time Picker icon

For any time field in EMS Regics, you can click the Time Picker icon to open a list from 
which you can select a time for the field. The list shows quarter hour time increments for a 
24 hour period.

Figure 1-11: Time Picker list
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An EMS Regics Browser Page
Several pages in EMS Regics are special pages known as an EMS Regics Browser page. 
Many options are available on an EMS Browser page for rearranging the page display to 
better suit your working needs. 

• To change the order of the columns on an EMS Regics Browser page, click and drag a 
column header to a new position.

Figure 1-12: Dragging a column to a new position on an EMS Regics Browser page
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• Initially, an EMS Regics Browser page is sorted in ascending order based on the 
Registration ID. To change the sort order based on descending order for a column, click 
the column header. To change the sort based on ascending order for the column, click the 
column header again.

Figure 1-13: Changing the sort order on an EMS Regics Browser page

• To group the information on an EMS Regics Browser page by a particular piece of 
information (for example, to group participants by Status on the Manage Participants 
page), drag the appropriate column header to the location indicated above the participant 
list.

Figure 1-14: Example of a participant list grouped by status

  

Click the first time to sort based on 
descending order of the value in 
the column.

Click a second to return 
ascending sort order.

Drag 
columns 
here.
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• To view the information for a participant or participants after you have grouped the 
participant list by a particular piece of information, click the Expand icon .

Figure 1-15: Viewing the information for participants grouped by Status

• To filter the display based on a specific value in the participants’ records, open the 
appropriate Filter list, and then select a filtering value.

Figure 1-16: Example of filtering a participants list based on Payment Type
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Event Registration Form and 
Survey Creation

The Dashboard is the starting point for creating an online event registration form or a survey 
in EMS Regics. You use the functions on this page and related pages to manage all aspects of 
creating an online event registration form or a survey for your organization, and for 
managing participant information.

This chapter covers the following topics:

• “Creating Event Registration Forms and Surveys” on page 27.
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Creating Event Registration Forms and Surveys
The Dashboard is the starting point for creating an online event registration form or a survey 
in EMS Regics. You use the functions on this page and related pages to manage all aspects of 
creating an online event registration form or a survey for your organization. You can also 
modify an existing event registration form or survey, delete an existing event registration 
form or survey, and manage participant information from the Dashboard.

To create an event registration form or survey

Figure 2-1:  Dashboard

1. On the Dashboard, click Create New Event or Create New Survey as appropriate.

The Add Event or Add Survey dialog box opens. The Event Type is selected accordingly 
(Registration or Survey), but you can always select the other value.

Figure 2-2:  Add Event dialog box
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2. Enter the information for the new event registration form or survey.

3. Click Create.

The Add Event dialog box and the Dashboard close, and the Add Event page opens. This 
page contains a series of tabs for adding the detailed information for the event 
registration form or survey. The Details tab is the active tab.

Figure 2-3:  Add Event page (for an event), Details tab

Table 2-1: New Event Registration or Survey Information

Item Description

Title The title or name for the event registration form or survey.

Event Type Registration or Survey. (You can select only one value.)

Group Tab A list of all available Group tabs on the Dashboard. You use Group tabs 
to organize your registration forms and surveys. The title for the event 
registration form or survey that you are adding (as well as other 
information) is displayed on the Group tab that you select here. By 
default, EMS Regics initially has only two tabs and these tabs are titled 
Events and Surveys. You can rename these tabs and you can also 
create additional tabs. See “Managing Group Tabs” on page 105.
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4. Add the information for the event registration form or survey. See:

• “Details tab” on page 30.

• “Design tab” on page 34.

• “Registrant tab/Respondent tab” on page 36.

• “Sections/Questions tab” on page 43.

• “Check Out tab” on page 58.

• “Emails tab” on page 59.

5. Click Save.

After you add your first event or survey, up to two additional Group tabs are displayed 
on the Dashboard—All and My Events. 

• The All Group tab displays all event registration forms and surveys that have been 
created in your EMS Regics system. 

• The My Events tab displays all the events and surveys that you created. (This means 
that the event or survey that you just created is available not only on the Group tab 
that you selected in Step 2, but also on the My Events tab.)

  

This step list the tabs in the order in which they appear on the Dashboard; 
however, you can enter the information for the event registration form or survey in 
any order that meets your business needs.

At any time when you are creating the event registration form or the survey, you 
can click Test/Preview to preview the event registration form or survey before 
registration for the event or the survey goes live. The pages that you see when you 
click Test/Preview are identical to the pages that participants see when they click 
the event registration link or survey link. Submissions of an event registration or 
survey are not counted as live registrations. Only the five most current 
registrations in test mode are saved to the database. The Sections/Questions tab 
also has a Preview Section function which you can click to preview a selected 
section instead of the entire event registration form or survey.

For information about Group tabs, see “Managing Group Tabs” on page 105.
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Details tab

Figure 2-4:  Add Event page (for an event), Details tab

Table 2-2: Details tab fields

Item Description

Status Active or Inactive. By default, the status for a new event registration 
form or survey is always set to Active. 

Note: Before you can delete an event registration form or survey, you 
must change the status to Inactive. 

Title The title or name for the event registration form or survey as you 
entered it on the Add Event page.

Note: If needed, you can edit the value on the Dashboard.
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Friendly Url Instead of using the fully encrypted URL format, you can use the 
Friendly URL format, which is a short and descriptive URL that a 
participant must click to open the online event registration form or 
survey. By default, the URL contains the title of the event or survey that 
you entered in Step 2 but you can edit this if needed. 

Note: Before you place the URL link on a site, you must click Validate 
to confirm that the link is fully functional.

Url The fully encrypted URL that a participant must click to open the online 
event registration form or survey. 

Note: For an event registration form, you typically place the URL link somewhere on the website 
where you are advertising the event. For either link, you should also click Test/Preview and 
confirm that you have the event registration form or survey pages designed exactly as you 
want them. The pages that you see when you click Test/Preview are identical to the pages 
that participants see when they click the URL link

Group tab The title for the event registration form or survey that you are adding (as 
well as other information) is displayed on the indicated tab. (Remember, 
you selected this tab in Step 2.) You can select a different tab if needed.

Status for new 
registrants

Available only for event registration forms. Values are Pending or 
Confirmed. 

Note: If you select Pending, you can later change the status for new 
registrants to Confirmed. For example, you might want to set the 
status to Pending for new registrants if the registrant must pay 
prior to attending the event. Then, after you have confirmed 
payment for the registrant, you can change the status to 
Confirmed. See “Managing Participants” on page 91.

Start Date/End Date Available only for event registration forms. The starting date and the 
ending date for the event.

Start Time/End Time Available only for event registration forms. The starting time and ending 
time for the event.

Timezone Available only for event registration forms. The timezone in which the 
event is scheduled.

Phase • Test: Allows you to set up and verify the event registration or survey 
link.

• Live: Allows a participant to “hit” the link and register for an event or 
take a survey.

• Closed: Registration for the event or the survey is complete. The link 
for event registration or the survey is no longer active.

Date to Go Live/Time The date and time at which the event registration/survey link is to go 
live.

Note: If you select Live for the phase, but you do not specify a time and 
date, then the link is live immediately upon saving the event 
registration form/survey.

Table 2-2: Details tab fields (continued)

Item Description
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Date to Close/Time The date and time at which the event registration/survey is to be closed 
to new participants.

Note: If you select Closed for the phase, but you do not specify a time 
and date, then the event/survey is closed immediately upon 
saving the event registration form/survey.

Capacity Available only for event registration forms. The maximum capacity for 
the event. If you do not want the event to have a maximum capacity, 
then do not change the default value of zero. When the number of 
registrants for an event equals the maximum capacity, new registration 
for the event is not allowed.

Note: If the maximum capacity for an event is reached, an option is 
available to accept wait-list registrations. See “Allow Wait List 
Registration” below.

Registration Type/
Survey Type

Values are:

• Open—Any participant who has access to the registration/survey link 
can register for the event/survey.

• Invitation Only—You must upload a list of participants, and then invite 
them to register using the registration link. See “To manage your 
invitees” on page 83.

Allow Anonymous? Available only for surveys. Select this option to allow a respondent to 
take the survey without providing any identifying information.

Note: When a survey is marked as Anonymous, a Skip Registration 
option is made available to the respondents.

Allow Multiple 
Registration 
Submissions (Not 
allowed with Group 
Registration)/Allow 
Multiple Survey 
Submissions

• For event registration forms—Select this option to allow a single 
registrant to complete multiple registrations that are tied to the same 
email address. Each registrant is assigned a unique registration 
number. For example, an administrative assistant could use this 
option to register three different employees for a conference. The 
registrations are tied to the assistant’s email address and therefore, 
the registration confirmation is sent to this address. The registration 
email, however, contains three distinct registration IDs for the three 
employees that were registered. 

• For surveys—Select this option to allow a single respondent to 
complete one or more surveys that are tied to the same email 
address. For example, as a customer of a software application, you 
might receive a “How Did We Do?” survey after the vendor’s 
technical support desk provides assistance to you. If you have more 
than one interaction from the support desk, you can still submit 
multiple, unique surveys that are tied to your single email address.

Note: For groups, you can add new registrants with an existing 
registration. These registrations are displayed under the same 
event manager, so EMS Regics does not consider them as 
separate, multiple registrations. See “Allow Group Registration” 
on page 33.

Table 2-2: Details tab fields (continued)

Item Description
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Allow Wait List 
Registration

Available only for event registration forms. Select this option to accept 
wait list registrations when the maximum capacity for the event is 
reached. 

Note: If the maximum capacity for the event is reached, and a 
confirmed registrant cancels their registration, then you must 
manually register wait-listed registrants for the event. See 
“Managing Participants” on page 91.

Accept Payment in Wait 
List Status

Available only for event registration forms and displayed only if Allow 
Wait List Registration is selected. Select this option to require wait-listed 
participants to make any necessary payments for the event. 

Allow Group 
Registration

Select this option to allow a single registrant to complete multiple 
registrations, with each registration tied to a unique email address. Not 
only does each registrant assigned a unique registration ID, but also 
each registrant receives his/her own registration confirmation email. For 
example, an administrative assistant could use this option to register 
three different employees for a conference but each employee is 
responsible for managing his/her own registration information after 
being registered for the event. 

Allow Registrant to Edit 
Registration/Allow 
Respondent to Edit 
Survey

Select this option to allow the participant to edit the registration/survey 
information up to and including the specified date. 

Send Notification When 
a Registrant Updates 
Their Information/Send 
Notification When a 
Respondent Updates 
Their Information

Available and selected by default only if you first selected Allow 
Registrant to Edit Information or Allow Respondent to Edit Information. 
A notification is sent to the event or survey contact when a participant 
updates their registration/survey information.

Allow Registrant to 
Cancel Registration

Available only for event registration forms. Select this option to allow 
confirmed registrants to cancel their registration up to and including the 
specified date.

Location Available only for event registration forms. The location where the event 
is to take place.

Location Url Available only for event registration forms. The URL (website address) 
for the event location’s web page.

Contact Name The name of the contact person for the event or survey. For example, 
this could be the name of the event organizer.

Contact Email The email address for the event or survey contact.

Contact Phone The phone number for the event or survey contact.

Email addresses that 
will be sent a notification 
when a registration is 
completed, edited or 
canceled

Available only for event registration forms. The indicated recipients 
receive an automatically generated email when a registrant is 
successfully registered for the event, or when a registrant edits or 
cancels a registration.

Table 2-2: Details tab fields (continued)

Item Description
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Design tab

Figure 2-5:  Add Event page, Design tab

Email addresses that 
will be sent a notification 
when a survey is 
completed or edited

Available only for surveys. The indicated recipients receive an 
automatically generated email when a respondent successfully 
completes a survey or edits a survey.

Table 2-2: Details tab fields (continued)

Item Description

Table 2-3: Design tab fields

Item Description

Theme Select a theme to apply to the event registration form or survey. The 
default theme is Regics Pro.

Theme Background 
Color

The background color for the selected theme for the online registration 
form or survey.
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Theme Font Color The color of any font in the selected theme for the online registration 
form or survey.

Header Image • Click Add Image to add an image that appears on the first page that 
opens after a participant clicks the event registration or survey link.

• Click Remove Image to remove the image.

Header Image 
Alignment

The alignment of the image on the first page of the event registration 
form or survey—Left, Center, or Right.

Header Description Use the options on this tab to design the format and layout of the 
Header information on the first page that opens after a participant clicks 
the event registration or survey link.

HIde Start/End Dates on 
Registration Form

Available only for event registration forms. Select this option if the event 
start date and end date are not to be displayed on the event registration 
form.

Include progress bar on 
form

Select this option if a progress bar is to be displayed on the registration 
form or survey as a participant fills it out.

Add Wait List Message Available only for events when the maximum capacity has been reached 
and the Wait List option has been enabled. Select this option to design 
the format and layout of a Wait List message on the first page that 
opens after a registrant clicks the event registration link.

Add Event Closed 
Message

Available only for events when an event has been closed. Select this 
option to design the format and layout of an Event Closed message on 
the first page that opens after a registrant clicks the event registration 
link.

Add Event Reached 
Capacity Message

Available only for events when the maximum capacity for an event has 
been reached. Select this option to design the format and layout of an 
Event Reached Capacity message on the first page that opens after a 
registrant clicks the event registration link.

Add Go Live Message Available for both events and surveys. Select this option to design the 
format and layout of a Go Live message (a message that indicates 
when the event registration form or survey link will be live or available) 
on the first page that opens after a participant clicks the event 
registration/survey link.

Note: If you have specified a Go Live date/time, but you do not add a 
custom-designed Go Live message, a default Go Live message 
is still displayed. 

Table 2-3: Design tab fields (continued)

Item Description
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Registrant tab/Respondent tab

The Registrant/Respondent tab displays all the pre-defined registrant/respondent fields that 
can be displayed on any registration form or survey. You can also add one or more custom 
registrant/respondent fields during the creation process. You typically use a custom 
registrant/respondent field to gather information about/ask questions of your participants. 

Figure 2-6:  Add Event page, Registrant tab/Respondent tab

• Select the fields into which a participant can/must enter information when registering for 
an event or responding to a survey.

• Visible selected, but Required not selected—The participant can enter information 
into this field, but the information is not required for the participant to successfully 
register for the event or complete the survey.

• Visible and Required both selected—The participant must enter the indicated 
information into the field to successfully register for the event or complete the survey.

• To make all fields Visible on the event registration form or survey, select Visible.

• To make all visible fields required on the event registration form or survey, select 
Required.

If you are creating an online event registration form, then the third tab on the Add 
Event page is labeled “Registrant.” If you are creating a survey, then the tab is 
labeled “Respondent.”

Although the statement “First and Last name are required and will be presented to 
the responder” is displayed on the Respondent tab, any survey that is set up as 
anonymous has a Skip Registration option for the respondents.
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• Actions—Available only for the custom registrant/respondent fields that you have 
manually added to the event registration form or survey that you are creating. You can 
click the Edit icon  to open the event registration form or survey form and edit the field, 
and you can click the Delete icon  to delete the field.

• To change the order in which the fields are to be displayed on the event registration form 
or survey, use the drag and drop feature.

To add a custom registrant/respondent field

When you add a custom registrant/respondent field to a registration form or survey, you must 
indicate the field type. Different field types serve different functions and different field types 
also have different options. Table 2-4 on page 38 details the field types that are available for 
a custom registrant/respondent field and the specific options that are available for each field 
type. It also provides examples as to why you would use one field type instead of another for 
a custom registrant/respondent field.

  

As an EMS Regics user, if you find that you need to add the same custom 
registrant/respondent field or fields to an event registration form or survey, 
contact your EMS Regics administrator about adding these fields to the global list 
of registrant/respondent fields. As an EMS Regics administrator, see “Managing 
Registrant/Respondent Fields” on page 108.
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Table 2-4: Custom registrant/respondent fields - Field types, descriptions, and options 

Field Type Description Availa

Default Value

Text The most unstructured of field types. When a participant enters 
text into a text field, the text is entered on a single, continuous line 
without any text wrapping.

Figure 2-7:  Text field

X

Text with area Although Text with area is also an unstructured field type, this field 
type provides for text wrapping and scrolling functions.

Figure 2-8:  Text with area field

X

Date For any date field in EMS Regics, participants can manually enter 
the date in any format, or they can click the Calendar Picker icon 
to open the Calendar Tool from which to select a date for the field. 

Figure 2-9:  Date field 

X

• Default value—The default value that is displayed for the question on the event registration form or survey
this value.
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Numeric The Numeric field format allows for whole numbers only.

Note: Numeric fields are indistinguishable in appearance from 
text fields; however, you cannot enter any non-numeric 
characters into a Numeric field.

X

• Default value—The default value that is displayed for the question on the event registration form or su
this value.

Note: If a minimum value is specified, the default value cannot be less than the minimum value. If a ma
default value cannot be greater than the maximum value.

• Min—The minimum value that a participant can enter into the field and successfully register for the ev
can specify a minimum value without a maximum value.

• Max—The maximum value that a participant can enter into the field and successfully register for the ev
can specify a maximum value without a minimum value.

List Select a field type of List if you are adding a list of items to a 
registration form or survey. A list field displays the entire list to a 
participant. A participant can scroll through the list and select one 
item only—the list items are mutually exclusive. This field type is 
particularly useful for situations in which multiple choices are 
available, but you want the participant limited to only one of the 
available choices, for example, a participant’s level of experience.

Figure 2-10: List field

Table 2-4: Custom registrant/respondent fields - Field types, descriptions, and options 

Field Type Description A

Default Value
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Table 2-4: Custom registrant/respondent fields - Field types, descriptions, and options 
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Radio button Select a field type of Radio button if you are adding a group of 
items to a registration form or survey from which a participant can 
select only one item a time—the items are mutually exclusive. 
This field type is particularly useful for situations in which multiple 
choices are available, but you want the participant limited to only 
one of the available choices, for example, a participant’s age 
group.

Figure 2-11: Radio button field

Check box You select a field type of Check box if you are adding a group of 
items to a registration form or survey from which a participant can 
simultaneously select multiple items. This field type is particularly 
useful for situations in which multiple choices are available and 
you want the participant to have access to all of the choices, for 
example, a participant’s goals for the event.

Figure 2-12: Check box field 

Field Type Description Availa

Default Value



Chapter 2
Event Registration Form and Survey Creation

41

X X

X X

rvey. A participant can modify 

ximum value is specified, the 

ent or complete the survey. You 

ent or complete the survey. You 

vailable Options

Min Max
EMS Regics User’s Manual

  

Decimal The Decimal field format allows for four places past the decimal 
point.

X

Percentage The Numeric field format allows for whole numbers only. You must 
manually enter a percentage sign (%) for this field to indicate that 
the field is a Percentage field and not simply a Numeric field.

X

• Default value—The default value that is displayed for the question on the event registration form or su
this value.

Note: If a minimum value is specified, the default value cannot be less than the minimum value. If a ma
default value cannot be greater than the maximum value.

• Min—The minimum value that a participant can enter into the field and successfully register for the ev
can specify a minimum value without a maximum value.

• Max—The maximum value that a participant can enter into the field and successfully register for the ev
can specify a maximum value without a minimum value.

Table 2-4: Custom registrant/respondent fields - Field types, descriptions, and options 

Field Type Description A

Default Value
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1. Add the top of the Registrant tab, click Add Field.

The User Defined Field dialog box opens.

Figure 2-13: User Defined field dialog box

2. Enter the information for the new field.

3. Click Save.

The User Defined Field dialog box remains open. You can repeat this procedure to add 
as many user-defined fields as needed, and then click Close to close the dialog box and 
return to the Registrant/Respondent tab. 

Required fields are marked with a red asterisk (*).

Table 2-5: User Defined Field dialog box fields

Item Description

Title The title/name for the user-defined field that is displayed in the Title field on 
the Registrant/Respondent tab.

Display text The field text that is displayed on the event registration form or survey. 

Field Type The type for the user-defined field, for example, a Text field, a Text field with 
a defined area, a Date field, and so on. See Table 2-4 on page 38.

Note: For a List, Radio button field, or Check box field, you can edit a list 
item within the question and you can order your list items within the 
question. The Description field holds a maximum of 500 characters.

Default Value The default value for the field. A participant can always edit this value.

Response Required Select this option if a participant must enter information in the field before 
they can register for the event or complete the survey.

Visible Selected by default. Clear this option to remove the field from an event 
registration form or survey.
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Sections/Questions tab

Figure 2-14: Dashboard, Sections/Questions tab

You use the options in this section to create a series of questions that relate to the event or to 
create the questions for a survey. A question can be for informational purposes only, or you 
can mark a question as Required, which means that participants must answer the question 
before they can register for the event or complete the survey. You can also use the Sections 
function to group related questions in the same category. For example, for an event, you 
could create questions that are grouped in an “Registrant Info” category, you could create 
another series of questions that are grouped into an “Registrant Fees” category, and so on. 
You can add new sections or questions, modify an existing section or question, and delete a 
section or question. When you add questions, you can create a dependency between 
questions. If you create a dependency for a question, a child question is displayed on the 
registration form or survey only if all its parent questions on which it is dependent are 
answered. For example, on an event registration form, a parent question could be “Are you 
attending the dinner prior to the conference kickoff? and a child question could be “Please 
select your dinner of choice.” If you have made the child question dependent on the answer 
to the parent question, then the child question is displayed on the registration form only if 
“Yes” is the answer that is supplied for the parent question. 

See:

• “To add a section” on page 44.

• “To edit a section” on page 44.

• “To delete a section” on page 45.

• “To create a question” on page 45.

• “To create a question by copying another question” on page 55.

• “To create a dependency between questions” on page 56.

• “To edit a question” on page 57.

• “To delete a question” on page 57.

Registration/survey questions are always displayed in the event contact email 
notification and you cannot change this.
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To add a section

1. Under Sections tab, click Add to open the Section dialog box.

Figure 2-15: Section dialog box

2. Enter the information for the new section.

3. Click Save.

4. Optionally, to preview this just this section, and not the entire registration form or 
survey, click Preview Section.

To edit a section

1. Open the section that is being edited.

2. Under Section Tabs, click Edit.

3. Modify the information for the section as needed.

4. Click Save.

5. Optionally, to preview this just this section, and not the entire registration form or 
survey, click Preview Section.

The Sections/Question tab has one default section defined as “Section 1.” 

Table 2-6: New Section fields

Item Description

Short Name The tab name as it is displayed on the Sections/Questions tab.

Title The section title that is displayed on the event registration form or survey. The 
title is displayed above the questions for the section.

Description Further explanation/information about the section questions. Displayed 
immediately below the section title on the event registration form or survey.
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To delete a section

1. Open the section that is being deleted.

2. Under Section Tabs, click Delete.

3. In the Delete dialog box, click Delete.

To create a question

You can create a question “from scratch” or you can create a question by copying an existing 
question and then making the necessary modifications to the question. When you create a 
question for a registration form or survey, you must indicate the field type for the question. 
Different field types serve different functions and different field types also have different 
options. Table 2-7 on page 46 details the field types that are available for a question and the 
specific options that are available for a field type. It also provides examples as to why you 
would use one field type instead of another for a question.

  

When you delete a section, all the questions in the section are also deleted. 
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Sections/Questions tab - Field types, descriptions, and options
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1. Open the section for which you are creating questions. 

2. Click Add Question.

The User Defined Field dialog box opens. 

Figure 2-22: User Defined Field dialog box

  

If you have only one section, then by default, all of the questions are placed in this 
section.
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3. Enter the information for the new question.

Required fields are marked with a red asterisk (*).

Table 2-8: New Question fields

Item Description

Title The title/name for the question that is displayed in the Title field on the 
Sections/Questions tab.

Display text The question text that is displayed for the field on the event registration form 
or survey. 

Notes Further explanation or information about the section that is displayed 
immediately above the first question on the event registration form or 
survey.

Hint Additional information or clarification that might help the participant answer 

the question. If a question has a hint, a Hint icon  appears next to the 

question. A participant can click this Hint icon to open and view the hint in its 
entirety.

Field Type The field type for the question, for example, a Text field, a Text field with a 
defined area, a Date field, and so on. See Table 2-7 on page 46.

Note: For a List, Radio Button, or Check box field, you can edit a list item 
within the question and you can order your list items within the 
question. The Description field holds a maximum of 500 characters.

Default Value The default value for the question. A participant can always edit this value.

Start Showing/Stop 
Showing

The date period during which the question is to be displayed on the event 
registration form or survey. 

• If you enter a value in both fields, then question is displayed on the 
registration form or survey beginning on the Start date and it is removed 
from the registration form or survey on the Stop date.

• If you leave both fields blank, then the question is always displayed on 
the event registration form or survey.

• If you do not enter a value for the Start date, but you do enter a value for 
the Stop date, then the question is displayed on the event registration 
form or survey only until the Stop date.

• If you enter a value for the Start date, but you do not enter a value for the 
Stop date, then the question is displayed on the registration form or 
survey until registration for the event or the survey is closed.

• If you want to show a question in advance of the Start date, but not have 
the question enabled until the Start date, select “Show in advance of 
availability.”

Show in advance of 
availability

Select this option to display the question before the question is enabled on 
the event registration form or survey. 

Response Required Select this option if a participant must answer the question before they can 
register for the event or complete the survey.
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4. Click Save.

The User Defined Field dialog box remains open. You can repeat this procedure to add 
as many user-defined questions as needed, and then click Close to close the dialog box 
and return to the <Section> tab. 

5. Optionally, to preview this just this section, and not the entire registration form or 
survey, click Preview Section.

6. Optionally, to create a dependency between questions, continue to “To create a 
dependency between questions” on page 56.

To create a question by copying another question

1. Open the section for which you are creating questions. 

2. Click the Copy icon  next to the question that you are copying.

A copy of the question is created.

Figure 2-23: Example of a copied question

3. Click the Edit icon  next to the copied question.

The question opens in the User Defined Field dialog box.

4. Edit the question as necessary, including the field type and its dependencies. 

5. Click Save.

Visible Selected by default. An override to the Start Showing/Stop Showing dates. 
Clear this option to remove the question from an event registration form or 
survey, regardless of the values in the Start Showing/Stop Showing fields.

The copied question is indicated with the word “Copy” at the end of the title. 

See “To create a question” on page 45 for a table that details the information that 
you can edit for a question. See “To create a dependency between questions” on 
page 56 for information about creating dependencies between questions.

Table 2-8: New Question fields (continued)

Item Description
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To create a dependency between questions

If you create a dependency for a question, a child question is displayed on the registration 
form or survey only if all its parent questions on which it is dependent are answered. For 
example, on an event registration form, a parent question could be “Are you attending the 
dinner prior to the conference kickoff? and a child question could be “Please select your 
dinner of choice.” If a registrant answers “Yes” to this question, and you have made the child 
question dependent on this answer, then the child question is displayed on the registration 
form. If the registrant answers “No” to the parent question, then the child question is not 
displayed. To make a child question dependent on the parent question:

• A parent question can be only one of three field types—List, Radio Button, or Check box.

• The child question must be placed anywhere after all its parent question in the list of 
questions.

1. Create the parent question. 

2. Create the child question.

3. Next to the child question, click the Create Dependency icon .

The Add Dependency dialog box opens. This dialog box lists all of the potential parent 
questions for the selected child question by Question Title. It also lists all of the available 
choices for each question.

Figure 2-24: Add Dependency dialog box

  

The parent question be only one of three field types—List, Radio Button, or Check 
box.

When you create the child question, you must place it anywhere after all its parent 
questions in the list of questions.
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4. Scroll to and select the correct option for each correct parent question, and then click 
Save.

For example, the parent question “Are you attending the dinner prior to the conference 
kickoff? is titled “Dinner” and the child question “Please select your dinner of choice” is 
to be displayed only if a registrant answers “Yes” to the parent question. In this case, you 
would select “Yes” under the “Attendee Dinner” entry in the Add Dependency check 
box.

To edit a question

1. Open the section that contains the question that is being edited. 

2. Click the Edit icon  next to the question.

3. Edit the question as necessary, including the field type and its dependencies. 

4. Click Save.

To delete a question

1. Open the section that contains the question that is being deleted. 

2. Click the Delete icon  next to the question.

A Delete dialog box opens, asking you if you want to delete this User Defined Field.

3. Click Delete.

The Delete dialog box closes. The question is deleted.

See “To create a question” on page 45 that details the information that you can 
edit for a question. See “To create a question” on page 45 that details the 
information that you can edit for a question. See “To create a dependency between 
questions” on page 56 for information about creating dependencies between 
questions.

You can also use the drag and drop feature to modify the order in which the 
questions are displayed in the section.
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Check Out tab

Figure 2-25: Check Out tab

Table 2-9: Check Out tab fields

Item Description

Payments

Payment Types Available only for events. List of available payment types as configured 
by your EMS Regics administrator. Select the options that are 
applicable for the event.

Note: As an EMS Regics user, if a particular payment type that you 
require is not an option, contact your EMS Regics administrator. 
As an EMS Regics administrator, for information about 
configuring payment types, see “Managing Payment Types” on 
page 112.

Add Payment Message Available only for events. Click this option to open a Payment Message 
dialog box and enter any relevant information about the payment 
methods that you are accepting for the event. For example, you might 
enter a message that a minimum processing charge of $5.00 is applied 
to all credit card payments. This message is displayed on the Checkout 
page when the event registration form goes live.

Note: To delete a payment message, click Edit Payment Message, 
clear the payment message in its entirety, and then save this 
change.

Settings

Show custom questions 
and checkout summary 
on checkout page?

Select this option to display a View Details link on the Checkout page 
that displays all the participant's responses to the questions that were 
asked of the participant.
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Emails tab

Figure 2-26: Emails tab

Include questions and 
answers in confirmation 
email

Select this option to display all the questions that were asked of the 
participant as well as the participant’s answers in the confirmation email 
that is sent to the participant.

Note: Registration/survey questions are always displayed in the event 
contact email notification.

Include terms & 
conditions

Select this option to open a text field in which you can enter such things 
as a Disclaimer statement, processing fees for payment installments, 
your cancellation policy, and so on. A participant must agree to these 
Terms and Conditions before he/she can submit a registration/survey.

Discounts—Available only for events. This section lists all the discounts (by Title and Status) that 
you have configured for the event. 

Add Discount Select this option to open the Discount dialog box and enter the 
information for a discount that can be applied to an event at checkout.

• Description—The description for the discount that is displayed on the 
Discounts list.

• Discount Code—The unique code that identifies the discount. A 
registrant must enter this code at checkout to redeem it. 

• Dollar Amount/Total Discount/—If the discount is to be a fixed dollar 
amount, then select Dollar Amount, and then in the Total Discount 
field, enter the amount.

• Percentage/Percentage of total—If the discount is to be a percentage 
of the total charges for the event, then select Percentage, and then in 
the Percentage of total field, enter the percentage.

• Active—Select this option if the discount is to be active and can be 
used by the registrants for the event.

Note: Discounts are applied only to those questions that have pricing 
defined and the Eligible with Percentage Discounts option 
selected.

Table 2-9: Check Out tab fields (continued)

Item Description
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You can do the following on the Emails tab:

• Configure a Confirmation message that is automatically generated and sent to the 
participant after a registration or survey is completed successfully or cancelled. See “To 
configure a new confirmation message” below.

• Configure a reminder that is automatically generated and sent to a registrant before an 
event on the date and time that you specify. The reminder can include an option to 
automatically send a survey to the registrants upon completion of the event. See “To 
configure a reminder” on page 62.

• Add an attachment to a confirmation message. This attachment is also included on the 
Event Details page. See “To add an attachment to a confirmation message” on page 64.

To configure a new confirmation message

You can configure one confirmation message for each of the three different participant 
statuses—Confirmed, Pending, and Cancelled. If Wait List registration is allowed for an 
event, then you can also configure an additional confirmation message for the Wait List 
status. When a participant registers for an event or submits a survey, the appropriate 
message, based on the participant’s status, is automatically generated and sent to the 
participant.

1. Next to the Confirmation Messages pane, click Add.

The Message dialog box opens.

Figure 2-27: Message dialog box
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2. Do one of the following:

• Enter the information for the new confirmation message.

• Click Lookup to open a Saved Messages dialog box. This dialog box lists all the 
global confirmation messages that have been configured in your EMS Regics 
system. Select the appropriate message, and then click Select. You can use this 
message “as-is,” or you can modify the message as needed.

3. Click Save.

The confirmation message is displayed (by Name) in the Confirmation Messages pane. 
Now, every time a participant submits a registration for the event or completes the 
survey, cancels a registration, or is assigned a Pending or Wait List status after 
registering for an event, a confirmation message, based on the participant’s status, is 
automatically generated and sent to the participant. 

Any modifications that you make to a global confirmation message apply only to 
this event or survey. The global confirmation message itself remains unchanged. 
As an EMS Regics user, contact your EMS Regics administrator for configuring 
any needed global confirmation messages. As an EMS Regics administrator, for 
information about configuring a global confirmation message, see “Managing 
Global Confirmation Messages” on page 122.

Table 2-10: Message dialog box fields

Field Description

Name The title/name for the confirmation message that is displayed in the 
Confirmation Messages pane on the Emails tab.

Status The participant status, which determines which confirmation message is 
automatically generated and sent to the participant. By default, the following 
statuses are always available—Pending, Confirmed, Cancelled, or Wait List.

Sender Email The email address that is displayed by default in the Sender field for the 
confirmation message. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender Email 
address.

Sender Name The name of the sender that is displayed by default in the in the Sender field 
for the confirmation message. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender Email 
address.

Subject The text that is displayed in the Subject line for the confirmation message. 
The default value is Registration Confirmation, but you an edit this value.

Message Use the formatting options at the top of the Message field to format (font, 
color, size, and so on) the confirmation message.

The email contains not only this confirmation message, but also a link to the Event 
Details page. See “Event Details page” on page 65.
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4. Optionally, select the message, and then click Email me to email yourself a “preview” of 
the confirmation message.

To configure a reminder

You can configure a reminder only for events. When a registrant receives a confirmation 
message, the message includes an option for the registrant to add the event to a personal 
calendar. If you want to send an automated reminder email before your event to registrants 
who have added the event to their personal calendars, you can configure a reminder and set 
the date and time for the reminder. You can add multiple reminders for an event. You also 
have the option of sending an automated post-event survey. 

1. Next to the Reminders pane, click Add.

The Add Reminder dialog box opens.

Figure 2-28: Add Reminder dialog box

  

To edit the confirmation message for an event or survey, select the message in the 
Confirmation Messages pane, and then click Edit. To delete a confirmation 
message for an event or survey, select the message in the Confirmation Messages 
pane, and then click Delete. When you delete a confirmation message for an event 
or survey, the message is no longer automatically generated for the event or 
survey; however, it is not deleted from the global list of confirmation messages.
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2. Add the information for the reminder.

3. Optionally, click Add Survey/Registration Link to open the Events dialog box and select 
a survey that is automatically sent to the registrants upon completion of the event.

Figure 2-29: Events dialog box

  

Table 2-11: Add Reminder dialog box fields

Field Description

Name The name/title for the reminder that is displayed in the Reminders pane 
on the Emails tab.

Date/Time The date and time at which the reminder is sent to the registrants who 
have added the event to their personal calendars.

Status The participant status, which determines which reminder message is 
automatically generated and sent to the participant. By default, the 
following statuses are always available—Pending, Confirmed, and Wait 
List.

Sender Email The email address that is displayed by default in the Sender field for the 
reminder. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender 
Email address.

Sender Name The name of the sender that is displayed by default in the in the Sender 
field for the reminder. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender 
Email address.

Subject The text that is displayed in the Subject line for the reminder. The default 
value is Reminder for registration named <Registration Name>, but you 
can edit this value.

Message Use the formatting options at the top of the Message field to format 
(font, color, size, and so on) the reminder.
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4. Click Save.

The reminder is displayed (by Title) in the Reminders pane. This reminder is 
automatically generated and sent at the indicated date and time to all the registrants with 
the selected status who have added the event to their personal calendars.

To add an attachment to a confirmation message

Any attachments that you specify here are attached to the confirmation messages that are 
displayed in the Confirmation Messages pane for the statuses of Confirmed, Pending, and 
Wait List. When you add an attachment to a confirmation message, the attachment is 
available from the Event Details page.

1. In the Attachments pane, click Attach a file.

The Choose File to Upload dialog box opens.

2. Browse to and select the file that is to be attached to the confirmation message, and then 
click Open.

The Choose File to Upload dialog box closes. The selected file is displayed (by file 
name) in the Attachments pane. 

To edit a reminder for an event, select the reminder in the reminders pane, and 
then click Edit. To delete a reminder for an event, select the reminder in the 
Reminders pane, and then click Delete.

For information about the options available to a participant on the Event Details 
page, see “Event Details page” on page 65.

To remove an attachment from a confirmation message, click the Remove icon  

next to the attachment.
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Event Details page
If you have configured the event registration form or survey so that confirmation message is 
automatically generated and sent to the participant after a registration or survey is completed 
successfully, then the confirmation message contains a link to the Event Details page. 

Figure 2-30: Event Details page

The Event Details page provides a detailed summary of the event information, including the 
following:

• A Personal Information section that details the personal information for the participant 
(Registration ID, Email, First Name, Last Name, and so on).

• If applicable, a Question Summary section that details the questions that were asked of 
the participant as well as the participant’s answers.

• If applicable, a Cart Summary section that details any pricing items that the participant 
has purchased.

• If applicable, an Attachments section that contains links for downloading any attachments 
that were included in the confirmation message.

Attachments

Links
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At the top of the Event Details page, up to three links are displayed. 

• Change Registration/Change Survey (Optional)—Participants can click Change 
Registration/Change Survey to return to the event or survey site and edit their current 
registration or survey information.

• My Activity—Participants can click My Activity to open the My Activity dialog box and 
view all the registrations and/or surveys that they have completed.

• Print Registration/Print Survey—Participants can click Print Registration/Print Survey to 
print a hard copy of the Event Details page.
66 EMS Regics User’s Manual



Chapter 3
Event Registration Form and 
Survey Management

You can manage an online event registration form or a survey for your organization, as well 
as participant information from two pages in EMS Regics—the Dashboard and the Event 
Dashboard. Although both pages provide options for managing a live registration form or 
survey and managing participants, the Event Dashboard page provides additional options for 
managing participants and events, such as creating Invitee lists, manually registering 
participants, and deleting test registrations.

This chapter covers the following topics:

• “Managing Event Registration Forms and Surveys from the Dashboard” on page 69.

• “Managing an Event or Survey from the Event Dashboard” on page 77.

• “Searching for Registrations and/or Surveys Completed by a Specific Participant” on 
page 89.

• “Managing Participants” on page 91.

• “Managing Group Tabs” on page 105.
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Managing Event Registration Forms and 
Surveys from the Dashboard

After you create an online event registration form or survey, the Dashboard is also the 
starting point for managing these forms and surveys in EMS Regics. After you search for and 
retrieve a registration form or survey, you can do the following from the Dashboard: 

• Print a list of event registration forms or surveys (Manage Events report or Manage 
Surveys report).

• Edit the information for an event registration form or survey.

• Create new event registration forms and surveys by copying an existing form or survey.

• Add and follow specific registration forms and/or surveys on the Favorites tab.

• Generate an Event Snapshot or Survey Snapshot report, which summarizes the current 
information for the event or survey, including the responses for all participants who have 
registered for the event or responded to the survey, within a specified date range.

• Delete an inactive event registration form or survey.

• View the history for the event registration form or survey.

• Manage the participants for the event or survey.

To search for an event registration form or survey from the 
Dashboard

1. Because the search feature that is available on the Dashboard is a tab-specific search, 
you must do one of the following:

• To search for all registration forms and surveys in your EMS Regics system, make 
sure that the All Group tab is open for the search.

• To search for only those registration forms or surveys that are found in a specific 
group, make sure that the appropriate Group tab is open for the search. 

  

To generate a Snapshot report which summarizes only the participant information, 
you must generate the report from the Manage Participants page. See “Managing 
Participants” on page 91.

For information about managing participants for an event or survey from the 
Dashboard, see “Managing Participants” on page 91.
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2. In the Title field on the Dashboard, enter the search criteria by which to search for an 
event registration form or survey. 

3. Optionally, select Show Past to search for live or closed events with a date that occurred 
before the current day’s date.

4. Click Find.

All the registration forms and surveys in your EMS Regics system that meet your search 
criteria are displayed on the opened Group tab.

Figure 3-1:  Dashboard with list of search results

5. Continue to any of the following as needed:

• “To print a list of event registration forms or surveys” on page 71.

• “To edit an event registration form or survey from the Dashboard” on page 71.

• “To create a new event registration form or survey by copying an existing form or 
survey from the Dashboard” on page 72.

• “Managing an Event or Survey from the Event Dashboard” on page 77.

• “To generate a Snapshot report for the event or survey” on page 73.

• “To delete an inactive event registration form or survey” on page 75.

• “To view the history for an event registration form or survey” on page 76.

Your search is limited to the exact order of the characters in the string, but the 
string can appear anywhere in the search results, and the search is not 
case-sensitive. For example, if you enter OU, search results can include campus 
tour, EMS Roundtable, and OU Summer Soccer Camp.

All registration forms or surveys with a Test status that meet the search criteria 
are always shown on the Dashboard, regardless of date.

Every specific Group tab is also refreshed with a list of results that meet your 
search criteria. If the list of search results that is returned on the All Group tab is 
too long to be effective, then you can open a specific Group tab to locate the 
needed search results.
70 EMS Regics User’s Manual



Chapter 3
Event Registration Form and Survey Management
To print a list of event registration forms or surveys

1. Optionally, click Show Past/Inactive if you want the printed list to include all past/
inactive forms or surveys that are contained on the tab.

2. Click Print.

The Manage Events report or Manage Surveys report opens. The report lists all the event 
registration forms or surveys that are contained on the Group tab. The report has options 
for printing the onscreen preview, exporting the list fields to a file such as a PDF, and so 
on. Place your mouse pointer on a toolbar button to open tooltip text for the button.

Figure 3-2:  Manage Events report example

To edit an event registration form or survey from the Dashboard

1. Click the Edit icon  next to the registration form or survey that you are editing.

The Add Event page opens. The Details tab is the active tab.

2. Modify the information for the event registration form or survey as needed. See:

• “Details tab” on page 30.

• “Design tab” on page 34.

• “Registrant tab/Respondent tab” on page 36.

• “Sections/Questions tab” on page 43.

• “Emails tab” on page 59.

3. Click Save.

4. Click OK in the Event Saved message.
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5. Click Done.

You return to the Dashboard.

To create a new event registration form or survey by copying an 
existing form or survey from the Dashboard

1. Click the Copy icon  next to the registration form or survey from which you are 

copying the information.

The Copy Event/Survey dialog box opens. This dialog box lists the title for the copied 
event registration form or survey as well as the start date and end date for the event or 
survey.

Figure 3-3:  Copy Event/Survey dialog box (for an event)

2. Do one of the following:

• Modify the title for the copied event or survey, and if needed, the Start Date and/or 
End Date, and then click Copy.

• Click Copy to modify this information later.

The copied registration form or survey opens in the Event Dashboard. See “Managing an 
Event or Survey from the Event Dashboard” on page 77.

Figure 3-4:  Copied event on a Group tab

A copy of the event registration form or survey is also displayed on the Group tab 
on the Dashboard. The copied form or survey is indicated with the word “Copy” 
at the end of the title. See Figure 3-4 below. You can always work with the copy of 
the event or survey from this tab if needed.
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To add a registration form or survey to your Favorites tab

If you have registration forms or surveys with which you must work frequently, then you do 
not need to search for them every time. Instead, you can create a personalized list of your 
favorite forms and surveys. This list is saved so it is displayed on the Favorites tab every 
time that you log in to EMS Regics. To add a registration form or survey to your Favorites 
tab, click the Favorites icon  next to the form or survey that is displayed on the 
Dashboard.

To generate a Snapshot report for the event or survey

An event or survey Snapshot report summarizes the current information for an event or 
survey, including the responses for all participants who have registered for the event or 
responded to the survey, within a specified date range.

1. Click the Event Snapshot icon  next to the appropriate event registration form or 
survey.

The Snapshot Report dialog box opens.

Figure 3-5:  Snapshot Report dialog box

2. Do one of the following:

• To generate a Snapshot report of up to and including the current day’s date, leave 
Add date range blank, and then click Run.

• To run a Snapshot report for a specific date range, click Add a date range, and then 
enter a Start date and an End date, and then click Run.

See Figure 3-6 on page 74.
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Figure 3-6:  Example of a Snapshot report for an event or survey

3. Click the Close button in the upper right corner of the Snapshot report to close the report 
and return to the Dashboard.

  

The Snapshot report has options for printing the onscreen preview, exporting the 
list fields to a file such as a PDF, and so on. Place your mouse pointer on a 
toolbar button to open tooltip text for the button
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To delete an inactive event registration form or survey

You can delete only inactive event registration forms or surveys from the Dashboard.

1. Click the Edit icon  next to the event registration form or survey that you are deleting.

The Add Event page opens. The Details tab is the active tab. 

Figure 3-7:  Add Event page (for an event), Details tab

2. Select Inactive.

3. Click Save.

4. Click OK in the Event Saved message.

  

You can delete test data from a event registration form or survey from the Event 
Dashboard. See “Managing an Event or Survey from the Event Dashboard” on 
page 77.
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5. Click Done.

You return to the Dashboard.

6. If needed, do one or both of the following:

• Click Past/Inactive to display all events/surveys that have occurred prior to the 
current day’s date or are inactive. 

• Search for the form or survey again. 

7. Click the Delete icon  next to the event registration form or survey that you are 

deleting.

A message opens, asking you if you are sure that you want to delete the event.

8. Click OK.

The message closes. A second message opens, indicating that the event was successfully 
deleted.

9. Click OK.

The second message closes. The selected form or survey is deleted immediately from the 
Group tab.

To view the history for an event registration form or survey

Open the History tab. The History tab is a view-only tab that shows the original creation date 
of the registration form or survey and the name of the Administrator or Standard user who 
created the registration form or survey. The tab also shows last date that the registration form 
or survey was edited as well as the name of the Administrator or Standard user who last 
edited the registration form or survey.

Figure 3-8:  History tab

The title for an inactive or previously occurring form or survey is displayed in red 
and italics.
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Managing an Event or Survey from the Event 
Dashboard

The Dashboard provides a global view of the events and surveys to which you have access. 
The Event Dashboard displays information about a specific event registration form or 
survey. Just like the Dashboard, the Event Dashboard has an edit registration form/survey 
option, a copy registration form/survey option, and a manage participants option; however, 
the following options are also available from the Event Dashboard:

• Previewing the event registration form or survey.

• Bypassing any date restrictions and complete the registration or survey for a participant. 
(The Admin Register function.)

• Deleting test data from an event registration form or survey.

• Finding a participant in the event or survey.

• Managing your invitee list for an invitation only event or survey.

• Viewing the history for an event registration form or survey.

To work with an event registration form or survey in the Event Dashboard, you must first 
search for the form or survey on the Dashboard. You can then can open the form or survey in 
the Event Dashboard and work with the form or survey as needed.

  

For information about managing the participants for an event registration form or 
survey from the Event Dashboard, see “Managing Participants” on page 91.

If you copied an existing form or survey on the Dashboard, then the copied form 
or survey is already opened in the Event Dashboard. You can continue to any of 
the following as needed:

• “To edit an event registration form or survey from the Event Dashboard” on 
page 80.

• “To preview an event or survey” on page 80.

• “To bypass date restrictions and complete a participant’s registration or 
survey” on page 81.

• “To create a new form or survey by copying an existing form or survey on the 
Event Dashboard” on page 81.

• “To delete test data from an event registration form or survey” on page 82.

• “To find participants in an event or survey” on page 83.

• “To manage your invitees” on page 83.

• “To view the history for an event registration form or survey” on page 88.
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To search for an event registration form or survey and open it in 
the Event Dashboard

1. Because the search feature that is available on the Dashboard is a tab-specific search, 
you must do one of the following:

• To search for all registration forms and surveys in your EMS Regics system, make 
sure that the All Group tab is open for the search.

• To search for only those registration forms or surveys that are found in a specific 
group, make sure that the appropriate Group tab is open for the search. 

2. In the Title field on the Dashboard, enter the search criteria by which to search for an 
event registration form or survey. 

3. Optionally, select Show Past to search for live or closed events with a date that occurred 
before the current day’s date.

4. Click Find.

All the registration forms and surveys in your EMS Regics system that meet your search 
criteria are displayed on the opened Group tab.

Figure 3-9:  Dashboard with list of search results

Your search is limited to the exact order of the characters in the string, but the 
string can appear anywhere in the search results. The search is not case-sensitive. 
For example, if you enter OU, search results can include campus tour, EMS 
Roundtable, and OU Summer Soccer Camp.

All registration forms or surveys with a Test status are always shown on the 
Dashboard, regardless of date.

Every specific Group tab is also refreshed with a list of results that meet your 
search criteria. If you carry out the search on the All Group tab, and you find that 
the list of search results that is returned on the All Group tab is too long to be 
effective, then you might want to open a specific Group tab to locate the needed 
search results.
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5. In the Title field, click the title of the appropriate event registration form or survey.

The Event Dashboard opens. The Details tab is the active tab.

Figure 3-10: Event Dashboard (for an event)

Figure 3-11: Event Dashboard (for a survey)
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6. Continue to any of the following as needed:

• “To edit an event registration form or survey from the Event Dashboard” below.

• “To preview an event or survey” on page 80.

• “To bypass date restrictions and complete a participant’s registration or survey” on 
page 81.

• “To create a new form or survey by copying an existing form or survey on the Event 
Dashboard” on page 81.

• “To delete test data from an event registration form or survey” on page 82.

• “To find participants in an event or survey” on page 83.

• “To manage your invitees” on page 83.

• “To view the history for an event registration form or survey” on page 88.

To edit an event registration form or survey from the Event 
Dashboard

1. In the Actions pane, click Edit Event or Edit Survey, as appropriate.

The Add Event page opens. The Details tab is the active tab.

2. Modify the information for the event registration form or survey as needed. See:

• “Details tab” on page 30.

• “Design tab” on page 34.

• “Registrant tab/Respondent tab” on page 36.

• “Sections/Questions tab” on page 43.

• “Emails tab” on page 59.

3. Click Save.

4. Click OK in the Event Saved message.

5. Click Done.

You return to the Event Dashboard.

To preview an event or survey

In the Actions pane, click Test/Preview. The pages that open when you click Test/Preview 
are identical to the pages that participants see when they click the URL link for the event or 
survey.
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To bypass date restrictions and complete a participant’s 
registration or survey

Sometimes, it might be necessary for an EMS Regics administrator to complete a 
participant’s registration or survey. For example, an event that your organization is hosting 
might have an early bird registration that has a reduced registration fee only for a specific 
time period and a standard registration time period with a higher registration fee. After the 
early bird registration time period has expired, any participant who has access to the 
event/survey link can register only at the standard registration price. To bypass these date 
restrictions and register an attendee at the early bird price, an EMS Regics administrator can 
use the Admin Register function. 

1. In the Actions pane, click Admin Register.

The event registration form or survey form opens.

2. Complete the registration form or survey for the participant.

To create a new form or survey by copying an existing form or 
survey on the Event Dashboard

1. In the Actions pane, click Copy Event or Copy Survey, as appropriate.

The Copy Event/Survey dialog box opens. This dialog box lists the title for the copied 
event or survey (appended with the word “Copy”) as well as the start date and end date 
for the event or survey.

Figure 3-12: Copy Event/Survey dialog box (for an event)

2. Do one of the following:

• Modify the title for the copied event or survey (as well as the Start Date and End 
Date, if needed), and then click Copy.

• Simply click Copy to modify this information later.

The Event Dashboard is refreshed with the information for the copied form or survey, 
including a link to the copied form or survey at the top of the page.

  

As an EMS Regics administrator, you can reuse an email address as needed when 
you are manually completing a registration or survey for a participant.
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3. In the Actions pane, click Edit Event or Edit Survey as appropriate.

The Add Event page opens. The Details tab is the active tab. 

4. Modify the information for the event registration form or survey as needed. See:

• “Details tab” on page 30.

• “Design tab” on page 34.

• “Registrant tab/Respondent tab” on page 36.

• “Sections/Questions tab” on page 43.

• “Emails tab” on page 59.

5. Click Save.

6. Click OK in the Event Saved message.

7. Click Done.

You return to the Event Dashboard.

To delete test data from an event registration form or survey

Before an event registration form or survey goes live, you should test the form or survey to 
ensure that you have it formatted as you want and that it is working correctly. EMS Regics 
allows for five completed test records to be saved for an event registration form or survey. 
After you complete a test event registration form or survey, and save the results, you can 
delete the test data from the form or survey before the form or survey goes live. To delete test 
data, in the Actions pane, click Delete Test Registration or Delete Test Survey as appropriate.

  

Delete Test Registration or Delete Test Survey is displayed in the Actions pane 
only if you have completed and saved at least one test record for the form or 
survey. Only the test data is deleted for the form or survey. The form or survey 
themselves are not deleted.
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To find participants in an event or survey

In the Details pane, do one of the following:

• To view a list of all participants for an event or survey, click the Down arrow in the Find 
Registrant in this Event/Find Respondent in this Survey field. A list of all participants 
who have registered for the event/taken the survey opens. This list is ordered by Last 
Name, First Name.

Figure 3-13: Participant list

• In the Find Registrant in this Event/Find Respondent in this Survey field, enter your 
search criteria, and then click Go.

As you enter your search string, the list of participants that meet your search criteria is 
dynamically updated. After you click Go, the Participant page opens with the list of 
participants who meet your search criteria. See “Managing Participants” on page 91.

To manage your invitees

If an event or survey is invitation-only, then only those participants that you specify, your 
invitees, have access to the link for the event or survey. You use the Invitee List functions 
that are available on the Dashboard page to create your Invitee list for an invitation-only 
event or survey. You can create your Invitee list automatically or you can create the list 
manually. You can also delete invitees from the Invitee list.

To automatically create your Invitee list

1. In the Invitee List pane, click Export Template.

A message opens, asking you if you want to open or save the InviteeList file, which is a 
comma-separated values (.csv) file.

Your search is limited to the exact order of the characters in the string, but the 
string can appear anywhere in the search results and the search is not 
case-sensitive. For example, if you enter scott, search results can include Scott, 
Katelyn and Terhune, Scott. 

No matter how you create your Invitee list, it is separate from the Participant list. 
Invitees to an invitation-only event or survey must still register for the event/
respond to the survey to appear in the Participant list.
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2. Click Open.

The InviteeList.csv file opens in Microsoft Excel. This file contains all the fields 
(standard, user-defined, and global) that have been specified as visible for the selected 
event or survey.

3. Enter the information for each invitee, and then save the file as a tab-delimited text file. 
(The file is named InviteeList.txt.)

4. In the Invitee List pane, click Import.

The Choose File to Upload dialog box opens.

5. Scroll to and select the tab-delimited text file (InviteeList.txt) that you just created and 
then click Open.

A dialog box opens indicating that the InviteeList.txt file is being uploaded.

6. Click OK to close the dialog box.

A second dialog box opens indicating that the text file was uploaded.

7. Click OK to close this second dialog box.

The Invitee Import dialog box opens. This dialog box lists all the invitees who will be 
imported into your EMS Regics application.

Figure 3-14: Invitee Import dialog box

A message might open indicating that the text file may contain features that are 
not compatible with Text (Tab delimited) and asking you if you want to keep the 
workbook in this format. Click Yes to keep the InviteeList file in a tab-delimited 
format when you save it.
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8. Optionally, before you import the Invitee list, click Edit next to each invitee as needed to 
edit the invitee’s information.

9. Click Upload.

A dialog box opens indicating that the import was successful.

10. Click OK to close the dialog box and remain on the Dashboard page.

When your invitees register for an event, or take a survey, a large portion of their 
information will already be populated with the information that you imported from the 
InviteeList text file. They can always edit their information if needed.

To manually create your Invitee list

You can manually create your entire Invitee list, or you can add more invitees to the Invitee 
list that you created automatically.

1. In the Invitee List pane, click Manage.

The Invitees page opens. If you have previously created and imported an Invitees list, 
then the information for the imported invitees is displayed on this page; otherwise, the 
page is blank.

Figure 3-15: Invitees page

2. Optionally, to sort the Invitee list by email (in reverse alphabetical order), click the Sort 
icon  next to the Email column heading. To change the sort order back to alphabetical 

order based on email, click the Sort icon again.

3. Under Actions, click Add.

The Add Invitee dialog box opens. See Figure 3-16 on page 86.
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Figure 3-16: Add Invitee dialog box

4. Add the information for the new invitee, and then click Save.

The Add Invitee dialog box closes and you return to the Invitees page with the newly 
added invitee displayed on the page.

5. Repeat Step 3 and Step 4 until you have added all the necessary invitees, and then click 
Back to return to the Dashboard page.

When your invitees register for an event, or take a survey, a large portion of their 
information will already be populated with the information that you entered in the Add 
Invitee dialog box. They can always edit their information if needed.

  

Required fields are marked with a red asterisk (*).
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To delete invitees from the Invitee list

1. In the Invitee List pane, click Manage.

The Invitees page opens. All the current invitees in your Invitees list are displayed on the 
page.

Figure 3-17: Invitees page

2. Optionally, to sort the Invitee list by email (in reverse alphabetical order), click the Sort 
icon  next to the Email column heading. To change the sort order back to alphabetical 

order based on email, click the Sort icon again.

3. Select the blank check box next to each invitee that you are deleting from your Invitees 
list. 

4. Under Actions, click Delete.

A dialog box opens, asking you if you are sure that you want to delete all checked 
invitees.

5. Click OK.

A second dialog box opens, indicating that the selected invitees were deleted.

6. Click OK.

The second dialog box closes. The invitee is deleted immediately from the Invitees list.

  

To select all invitees in a single step, select the blank check box in the column 
heading row (the check box to the left of Email.)
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To view the history for an event registration form or survey

On the Event Dashboard, open the History tab. The tab displays all the history for the event 
registration form or survey—the date of the change to the form or survey, the name of the 
user who made the change, the field that was changed, the old field value, and the new field 
value. 

Figure 3-18: Event Registration Form, History tab (Event Dashboard)
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Searching for Registrations and/or Surveys 
Completed by a Specific Participant

The Participants search feature is an option that is available from the EMS Regics menu. You 
can use this option to search across all the forms and surveys in your EMS Regics system for 
the registration and/or surveys that were completed by a specific participant.

To search for registration and/or surveys completed by a specific 
participant

1. On the EMS Regics menu, click Participants.

The Participants page opens. The search options are displayed at the top of the page.

Figure 3-19: Participants page with search options

2. Enter your search options.

• Leave all search fields blank to search for all participants who have registered for an 
event or completed a survey in your EMS Regics system.

• First Name, Last Name, and Email—Your search is limited to the exact order of the 
characters in the string, but the string can appear anywhere in the search results. The 
search is not case-sensitive. For example, if you enter Son in the Last Name field, 
then search results can include Johnson, Sondeheim, and so on.

• Registration ID—Your search is limited to the exact order of the characters in the 
string, and the search results must begin with the string. For example, if you enter 
100 in the Registration ID field, then search results can include 100001, 100002, but 
not 001100.

  

To search for the registrants for a specific event, or the respondents for a specific 
survey, you must do so from the Manage Participants page. See “Managing 
Participants” on page 91.
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3. Click Search.

A list of participants who meet all the search criteria that you specified is displayed on 
the Participants page.

Figure 3-20: Participants page with search results

4. Optionally, do one or both of the following:

• Rearrange the search results to better suit your working needs.

• Export the list of participants:

1. On the Format dropdown list, select the format to which you are exporting the 
list of participants. (PDF is the default value.)

2. Click Export.

A message opens, asking you if you want to open the file or save the file.

3. Do one of the following:

• To view the file online (you cannot rename or save the file), click Open.

• To save the file to a location of your choice (you can also rename the file), 
click Save.

See “An EMS Regics Browser Page” on page 22.
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Managing Participants
After you search for and retrieve a specific event registration form or survey, you can 
manage the participants for the form or survey from the Manage Participants page. 
Managing participants consists of:

• Viewing and editing the information for a participant (changing a registrant’s status and/
or secondary status, adding/editing/deleting a registrant’s transaction information, 
processing a credit card refund for a registrant, adding notes to a participant’s record, 
viewing the history for a participant’s record, viewing a list of all the emails that were sent 
to the participant, resending a confirmation to a participant sending an itemized receipt to 
a registrant, and/or sending a request for payment due to a registrant).

• Viewing a list of participants who have not completed the necessary forms or surveys 
(incomplete participants).

• Changing the status for multiple event registrants.

• Sending email to a participant or participants.

• Generating a list of addresses for participants (the Address List report).

• Generating a Participant Snapshot report, which is a list of all the responses provided by 
all participants for the time period up to and including the current day’s date and time.

• Exporting a list of participants for the event or survey to a PDF, XLS, or CSV file.

To manage participants

1. Search for the event registration form or survey form for which you are managing the 
participants. See:

• “To search for an event registration form or survey from the Dashboard” on page 69

or

• “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

  

To generate an Event Snapshot or Survey Snapshot report, which includes not only 
the participant responses, but also the summary information for the relevant event 
or survey, you must generate the report from the Dashboard or from the Reports 
tab on the Event Dashboard. See “Managing Event Registration Forms and 
Surveys from the Dashboard” on page 69 or “Generating Standard Reports” on 
page 164.
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2. Do one of the following:

• On the Dashboard, click the Participants icon  next to the event registration form 

or survey for which you are managing the participants.

• On the Event Dashboard page, under Actions, click Registrants or Respondents, as 
appropriate.

The Manage Participants page opens. This page lists all the participants who have 
completed their registrations and/or surveys for their events. When the page first opens, 
the participants are grouped by Registration ID. 

Figure 3-21: Manage Participants page

3. Optionally, before you continue, do one or both of the following:

• To also show the participants who have not completed the necessary forms or 
surveys, click Include Incomplete.

• Rearrange the search results on the Manage Participants page to better suit your 
working needs. 

  

To search across all the forms and surveys in your EMS Regics system for the 
registration and/or surveys that were completed by a specific participant, you 
must do so from the Participants page. See “Searching for Registrations and/or 
Surveys Completed by a Specific Participant” on page 89.

An Incompletes report is also available. See “Generating Standard Reports” on 
page 164.

See “An EMS Regics Browser Page” on page 22.
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4. Continue to any of the following as needed:

• “To view and edit the information for a participant” below.

• “To change the status for multiple event registrants” on page 100.

• “To send an email to one or more participants” on page 100.

• “To generate a list of participants’ addresses (Address List report)” on page 102.

• “To generate a Participant Snapshot report” on page 103.

• “To export a list of participants to a file” on page 104.

To view and edit the information for a participant

You can edit the personal information that the participant entered on the event registration 
form or survey and the answers to any of the questions. You can also view the history for the 
participant’s record, add notes to the participant’s record, add, edit, or delete transactions for 
a registrant, including marking the participant as “Billed” for an event, and refunding a credit 
card payment. Finally, you can change the (primary) status for a participant, assign or change 
the secondary status for an event registrant, resend a confirmation to a participant, send an 
itemized receipt to an event registrant and/or send a payment due request to an event 
registrant.

1. Click the Registration ID for the participant.

The Edit Registrant/Edit Respondent dialog box opens. The dialog box contains a series 
of tabs for editing the information for a participant. The Questions tab is the active tab. 
See Figure 3-22 on page 94.

If you do now want to continue, you can click Back to return to the Event 
Dashboard (Details tab), and carry out other work as needed. See Step 6 of “To 
search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

If you are editing the information for an event registrant, then the Edit Registrant 
dialog box opens. If you are editing the information for a survey respondent, then 
the Edit Respondent dialog box opens.
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Figure 3-22: Edit Registrant/Edit Respondent dialog box, Questions tab

2. Edit any and all of the information for the participant as necessary. See:

• “Questions tab” on page 96.

• “Notes tab” on page 97.

• “Accounting tab” on page 98.

3. Under Actions, click any of the following as needed:

Table 3-1: Available actions when editing a participant

Action Description

Change Status Open the Change Status dialog box and change the status of the 
participant (for example, from Pending to Confirmed for an event 
registrant).

Figure 3-23: Change Status dialog box

Note: You can change the status of only one participant at a time with 
this option. To change the status of multiple participants, you 
must do so from the Manage Participants page. See “To change 
the status for multiple event registrants” on page 100.
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4. If the participant owes a payment for the event, then optionally, click Send Payment 
Request to have an automatic payment request that details the amount due for the event 
sent to the registrant.

5. Optionally, do one or both of the following:

• Open the History tab to view the history for the participant’s record, which is a list of 
all the edits made to the participant’s record and includes the edit date, the name of 
the Standard or Administrative user who edited the record, the field that was edited 
for the record, and the old and new values for the field. 

Figure 3-25: Edit Registrant/Respondent dialog box, History tab

  

Secondary Status Open the Secondary Statuses dialog box and assign/change the 
secondary status of the registrant. For example, if a confirmed registrant 
does not attend the event, select a secondary status of No Show.

Figure 3-24: Secondary Statuses dialog box

Note: Your EMS Regics administrator configures the secondary status 
values. Contact your administrator if you need specific values 
configured. For information about configuring secondary 
statuses, see “Managing Secondary Statuses” on page 126.

Resend Confirmation Send a Confirmation email again to a participant who has been 
confirmed for an event or submitted a survey

Send Receipt Automatically send a itemized receipt that lists the items purchased, 
their pricing, the total billed and paid, and any amount due to the event 
registrant.

Table 3-1: Available actions when editing a participant (continued)

Action Description
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• Open the Emails to tab to view a list of all the emails that have been sent to the 
participant. The list details the date that each email was sent, the user name for the 
user who sent the email, the email address from which the email was sent, the 
subject of the email, and whether attachments were included for the email.

Figure 3-26: Edit Registrant/Respondent dialog box, Emails tab

6. When you are done editing and/or viewing the information for the participant, click 
Close on the Edit Registrant/Edit Respondent dialog box. 

You return to the Manage Participants page.

Questions tab

Figure 3-27: Edit Registrant/Edit Respondent dialog box, Questions tab
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1. Edit the personal information that the participant entered on the event registration form 
or survey as well as the answers that they provided to any questions. 

2. Click Save to save the changes to the participant record, and then continue with any 
other editing of the participant record as needed; otherwise, click Close return to the 
Manage Participants page. 

Notes tab

Figure 3-28: Edit Registrant/Edit Respondent dialog box, Notes tab

1. Enter any additional information that is pertinent to the participant.

2. Click Save to save the changes to the participant record, and then continue with any 
other editing of the participant record as needed; otherwise, click Close return to the 
Manage Participants page. 

  

Required fields are marked with a red asterisk (*).
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Accounting tab

Figure 3-29: Edit Registrant dialog box, Accounting tab

Figure 3-30: Edit Registrant dialog box, Accounting tab with credit card payment processing 
enabled

  

For details about enabling credit card payment processing, see the EMS Regics 
Installation Instructions.
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1. Do one or more of the following as needed:

• Select Billed to indicate that the registrant has been billed for the event.

• If available, for a credit card transaction, click Refund to open the Refund dialog box 
and process a refund for the transaction.

Figure 3-31: Refund dialog box

• Click Add Transaction to open the Transactions dialog box and enter a new 
transaction (amount, payment type, and optionally, notes) for the registrant.

Figure 3-32: Transactions dialog box

• Under Actions, click the Edit icon  or Delete  icon next to an existing 

transaction to edit or delete an existing transaction for the registrant, respectively.

  

When the Refund dialog box first opens, the Amount to refund is set by default to 
the full purchase price. If a partial refund has already been issued, then the 
Amount to refund is set to the remaining balance. You can always edit these 
values.
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2. Click Save to save the changes to the registrant record, and then continue with any other 
editing of the registrant record as needed; otherwise, click Close return to the Manage 
Participants page. 

To change the status for multiple event registrants

1. Select the blank check box for a registrant or registrants. 

2. Under Actions, click Change Status.

The Change Status dialog box opens.

Figure 3-33: Change Status dialog box

3. Select the new status for the registrants.

4. Click Change.

The status of the selected registrants is updated immediately on the Manage Participants 
page.

To send an email to one or more participants

1. Select the blank check box for a participant or participants.

  

To select all event registrants, select the blank check box next to the Registration 
ID column header.

Select the Inactive status to flag invalid registrations for the Testing phase or the 
Live phase.

To send an email to a participant, the participant must have a valid email address.

To select all participants that are currently displayed, select the blank check box 
next to the Registration ID column header. If you have multiple pages of 
participants to select, you must repeat this step on each page.
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2. Under Actions, click Send Email.

The Send Email dialog box opens. The Sender Email field and Sender Name field are 
automatically populated with default values set by your EMS Regics administrator, but 
you can edit these values. 

Figure 3-34: Send Email dialog box

3. Do one of the following:

• Click Lookup to open a Saved Emails dialog box. This dialog box lists all the global 
emails messages that have been configured in your EMS Regics system. Select the 
appropriate message, and then click Select. You can use this message as-is, or you 
can modify the message as needed.

Figure 3-35: Saved Emails dialog box

• Enter a subject and message for a one-time email message.
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4. Optionally, do one or more or all of the following as needed:

• Use the options on the formatting toolbar to format the body of your message.

• Select from a list of Participant Fields and/or Event Fields to be included in the 
message. If you include Participant Fields and/or Event Fields in the message, then 
the message is personalized based on the values in the selected fields for each 
message recipient.

• Select Email me a copy to have a copy of the email sent to your email address that is 
on file with the application (the email address that you used to log in to EMS 
Regics).

• Click Attach File to open a Choose File to Upload dialog box and then browse to and 
select the file that is to be sent as an attachment with the email.

5. Click Send.

To generate a list of participants’ addresses (Address List report)

The Address List includes both physical addresses and email addresses.

1. Select the blank check box for a participant or participants.

2. Under Actions, click Address List.

The Address List report opens. The report lists the name for each participant as well as 
the participant’s email an physical addresses. 

Figure 3-36: Address List report example

Any modifications that you make to a global email message apply only to this 
email. The global email message itself remains unchanged. For information about 
configuring a global email message, see “Managing Global Emails” on page 118.

To select all participants, select the blank check box next to the Registration ID 
column header. If you have multiple pages of participants to select, you must 
repeat this step on each page.

The Address List report has options for printing the onscreen preview, exporting 
the list fields to a file such as a PDF, and so on. Place your mouse pointer on a 
toolbar button to open tooltip text for the button.
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To generate a Participant Snapshot report

A Participant Snapshot report displays all the responses from all the participants for an 
event or survey for the time period up to and including the current day’s date and time.

1. Select the blank check box for a participant or participants. 

2. Under Actions, click Snapshot.

The Participant Snapshot report opens.

Figure 3-37: Participant Snapshot report example

To generate a Snapshot report that also includes summary information for the 
relevant event or survey (the Event Snapshot report or the Survey Snapshot 
report), you must generate the report from the Dashboard. See “Managing Event 
Registration Forms and Surveys from the Dashboard” on page 69.

To select all participants, select the blank check box next to the Registration ID 
column header. If you have multiple pages of participants to select, you must 
repeat this step on each page.

The Participant Snapshot report has options for printing the onscreen preview, 
exporting the list fields to a file such as a PDF, and so on. Place your mouse 
pointer on a toolbar button to open tooltip text for the button.
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To export a list of participants to a file

You can export of list of participants for an event or survey to a PDF file (Export to PDF), to 
an Excel file (Export to XLS) or to a comma-separated values file (CSV).

1. Select the blank check box for a participant or participants.

2. On the Format dropdown list, select the format to which you are exporting the 
participant list. (PDF is the default value.)

3. Click Export.

A message opens, asking you if you want to open the file or save the file.

4. Do one of the following:

• To view the file online (you cannot rename or save the file), click Open.

• To save the file to a location of your choice (you can also rename the file), click 
Save.

To select all participants, select the blank check box next to the Registration ID 
column header. If you have multiple pages of participants to select, you must 
repeat this step on each page.
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Managing Group Tabs
You use Group tabs to organize your registration forms and surveys. By default, EMS Regics 
initially has only two tabs and these tabs are titled Events and Surveys. You can rename these 
two tabs and you can also create additional tabs. You can also delete a tab if the tab does not 
hold any registration forms or surveys, including those that occurred in the past.

To rename a Group tab

1. Open the Group tab that you are renaming.

2. On the Dashboard, under Group tab, click Edit.

The Group tab dialog box opens. The name of the currently opened tab is displayed in 
Name field.

Figure 3-38: Group tab dialog box

3. Edit the name of the tab.

4. Click Save.

The tab name is updated immediately on the Dashboard.

To create a Group tab

1. On the Dashboard, under Group tab, click Add.

The Group tab dialog box opens. The Name field is blank.

Figure 3-39: Group tab dialog box

2. Enter the name of the tab.

You cannot rename or delete the All Group tab or the My Events Group tab.
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3. Click Save.

The Event Registration/Survey page is updated immediately with the new tab.

To delete a Group tab

1. Open the Group tab that is being deleted.

2. Delete all registration forms or surveys (including past forms or surveys) from the tab. 

3. With the Group tab open, under Group Tab, click Delete.

The Group tab is deleted immediately from the Dashboard.

The Delete option is available for the Group tab only if the opened tab contains no 
registration forms or surveys. If the tab is blank, but the Delete option is not 
available, click Show Past to refresh the tab with all forms or surveys with a date 
that occurred before the current day’s date and then delete these forms or surveys.

You can delete an event or survey only if it is inactive. See “To delete an inactive 
event registration form or survey” on page 75.
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Administration - Configuration

This chapter details the configuration functions that are available in EMS Regics.

This chapter covers the following topics:

• “Managing Registrant/Respondent Fields” on page 108.

• “Managing Payment Types” on page 112.

• “Managing Global Emails” on page 118.

• “Managing Global Confirmation Messages” on page 122.

• “Managing Secondary Statuses” on page 126.

• “Managing Item Level Tax Rates” on page 128.
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Managing Registrant/Respondent Fields
The registrant/respondent fields in the global list of fields can be displayed and/or required 
on any and all event registration forms and surveys. Managing registrant/respondent fields 
consists of adding new registrant/respondent fields to the global list of fields, editing 
registrant/respondent fields, and deleting registrant/respondent fields. You can also print a 
list of registrant/respondent fields (the Registrant Fields report or the Respondent Fields 
report).

To add a registrant/respondent field

1. On the EMS Regics menu, click Admin > Configuration > Registrant/Respondent 
Fields.

The Registrant/Respondent Fields page opens. This page lists all the active 
registrant/respondent fields that can be displayed and/or required for any event 
registration form or survey.

Figure 4-1:  Registrant/Respondent Fields page

2. Optionally, to show all registrant/respondent fields, whether active or inactive, select 
Show Inactive.
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3. Click Add Field.

The User Defined Field dialog box opens.

Figure 4-2:  User Defined Field dialog box

4. Enter the information for the registrant/respondent field.

5. Click Save.

6. Click Close to close the dialog box and return to the Registrant/Respondent Fields page.

  

Table 4-1: User Defined Field dialog box fields

Item Description

Title The title/name for the registrant/respondent field that is displayed in the 
Title field on the Registrant/Respondent tab.

Display text The field text that is displayed on the event registration form or survey. 

Field Type The type for the user-defined field, for example, a Text field, a Text field 
with a defined area, a Date field, and so on. See Table 2-4 on page 38.

Note: For a List, Radio button field, or Check Box field, you can edit a 
list item within the question and you can order your list items 
within the question.The Description field holds a maximum of 
500 characters.

Default Value The default value for the field. A participant can always edit this value.

Response Required Select this option if a participant must enter information in the field 
before they can register for the event or complete the survey.

Visible Selected by default. Clear this option to remove the field from an event 
registration form or survey.
EMS Regics User’s Manual 109



Chapter 4
EMS Regics System Administration - Configuration
To edit a registrant/respondent field

1. On the EMS Regics menu, click Admin > Configuration > Registrant/Respondent 
Fields.

The Registrant/Respondent Fields page opens. See Figure 4-1 on page 108.

2. Optionally, do one or more of the following for a field:

• Change the Visible, Required, and/or Active status for a field.

• If an Edit icon  is displayed next to the field, click the icon to open the User 

Defined field dialog box and edit the information for the field as needed.

3. Do one or both of the following:

• If you edited any information in the User Defined field dialog box, click Save on the 
dialog box and then click Close to close the dialog box and return to the Registrant/
Respondent Fields page.

• If you changed the Visible, Required, and/or Active Status for a field, then click 
Save at the bottom of the Registrant/Respondent Fields page.

To delete a registrant/respondent field

You can delete a registrant/respondent field only if no data has been entered into the field for 
any registration form or survey. If you can delete a registrant/respondent field, then a Delete 
icon  is displayed next to it on the Registrant/Respondent Fields page.

1. On the EMS Regics menu, click Admin > Configuration > Registrant/Respondent 
Fields.

The Registrant/Respondent Fields page opens. See Figure 4-1 on page 108.

2. Click the Delete icon  next to the registrant/respondent field that is to be deleted.

A message opens, asking you if you are sure that want to delete the registrant/respondent 
field.

3. Click OK.

A second message opens, stating that the selected registrant/respondent field was 
deleted.

4. Click OK.

The second message closes. The field is deleted immediately from the Registrant/
Respondent Fields page.

.See Table 4-1 on page 109.
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To print a list of registrant/respondent fields

1. On the EMS Regics menu, click Admin > Configuration > Registrant/Respondent 
Fields.

The Registrant/Respondent Fields page opens. This page lists all the active registrant/
respondent fields that can be displayed and/or required for any event registration form or 
survey. See Figure 4-1 on page 108.

2. Optionally, to include all inactive registrant/respondent fields in the report, select Show 
Inactive.

3. Click Print. 

The Registrant Fields/Respondent Fields report opens. The onscreen report lists all the 
active and if applicable, inactive registrant/respondent fields in your EMS Regics 
system. 

Figure 4-3:  Registrant Fields report example

The Registrant Fields report has options for printing the onscreen preview, 
exporting the list fields to a file such as a PDF, and so on. Place your mouse 
pointer on a toolbar button to open tooltip text for the button.
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Managing Payment Types
You can add the different payment types that your organization accepts to your EMS Regics 
system. These payment types are displayed on the Checkout page for an event registration 
form. In addition, you can add custom questions for a payment type that are also displayed 
on the Checkout page for a registration form. You can edit a payment type and you can delete 
a payment type only if it has not been selected on the Checkout page for any event 
registration form. 

To add payment types

1. On the EMS Regics menu, click Admin > Configuration > Payment Types.

The Payment Types page opens. The Active tab is the tab that opens by default. This tab 
displays all the active payment types that have been configured in your EMS Regics 
system.

Figure 4-4:  Payment Types page

  

Optionally, to view inactive payment types, open the Inactive tab.
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2. Click Add Payment Type.

The Add Payment Type dialog box opens.

Figure 4-5:  Add Payment Type dialog box

3. In the Title field, enter the title/name for the payment type. (This title/name is displayed 
in the Description field on the Payment Types page.)

4. If the payment type is a credit card, select Credit Card.

5. Click Create.

The Payment Type Details page opens. The Details tab is the active tab. The title/name 
that you just entered in Step 3 is displayed in the Description field. By default, the 
payment type is added as Active.

Figure 4-6:  Payment Type Details page, Details tab

6. Do one or both of the following as needed:

• On the Gateways dropdown list, select the appropriate Gateway for the payment 
type. 

• Open the Custom Questions tab and add one more custom questions for the payment 
type. See “To add a custom question to a payment type” on page 114.

See the EMS Regics Installation Instructions for detailed information about 
configuring gateways.
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7. Click Save.

The Payment Type Details page closes. You return to the Payment Types page with the 
newly added payment type displayed on the page.

To add a custom question to a payment type

1. If you have not already done so, open the payment type for which you are adding the 
custom questions in the Payment Types details page. (From the Payment Types page, 
click the title/name of the payment type in the Description column.)

Figure 4-7:  Payment Type Details page, Details tab

2. Open the Custom Questions tab, and on the tab, click Add Question.

The User Defined Field dialog box opens.

Figure 4-8:  User Defined Field dialog box
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3. Enter the information for the new question.

4. Click Save.

The User Defined Field dialog box remains open. 

5. Repeat Step 3 and Step 4 until you have added as many custom questions as needed, and 
then click Close to close the dialog box and return to the Custom Questions tab. 

6. Click Save on the Payment Type Details page to close the page and return to the 
Payment Types page.

  

Required fields are marked with a red asterisk (*).

Table 4-2: User Defined Field dialog box fields

Item Description

Title The title/name for the question that is displayed in the Title field on the 
Custom Questions tab.

Display text The question text that is displayed on the event registration form or 
survey. 

Notes Further explanation or information about the section that is displayed 
immediately above the first question on the event registration form or 
survey.

Hint Additional information or clarification that might help the participant 

answer the question. If a question has a hint, a Hint icon  appears 

next to the question. A participant can click this Hint icon to open and 
view the hint in its entirety.

Field Type The field type for the question, for example, a Text field, a Text field with 
a defined area, a Date field, and so on. See Table 2-7 on page 46.

Note: For a List, Radio Button, or Check box field, you can edit a list 
item within the question and you can order your list items within 
the question. The Description field holds a maximum of 500 
characters.

Default Value The default value for the question. A participant can always edit this 
value.

Response Required Select this option if a participant must answer the question before they 
can register for the event or complete the survey.

Visible Selected by default, it is an override to the Start Showing/Stop Showing 
dates. Clear this option to remove the question from event registration 
form or survey, regardless of the values in the Start Showing/Stop 
Showing fields.
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To edit a payment type

1. On the EMS Regics menu, click Admin > Configuration > Payment Types.

The Payment Types page opens. The Active tab is the tab that opens by default.

2. In the Description field, click the title/name of the payment type that is to be edited.

The Payment Type Details page opens. The Details tab is the active tab.

Figure 4-9:  Payment Type Details page, Details tab

3. Do one or more of the following as needed:

• On the Gateways dropdown list, select the appropriate gateway for the payment 
type, or select a different gateway. 

• To inactive a payment type, clear the Active option.

• Open the Custom Questions tab and do one or more or all of the following as 
needed:

• Add one more custom questions for the payment type. See “To add a custom 
question to a payment type” on page 114.

• Click the Edit icon  next to a custom question to edit the question.

• Click the Delete icon  next to a custom question to delete it. 

4. Click Save to save the changes to the payment type and return to the Payment Type page.

  

See the EMS Regics Installation Instructions for detailed information about 
configuring gateways.
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To delete a payment type

You can delete a payment type only if it has not been selected on the Checkout page for an 
event registration form. If you can delete a payment type, then a Delete icon  is displayed 
next to it on the Payments type page.

1. On the EMS Regics menu, click Admin > Configuration > Payment Types.

The Payment Types page opens.

2. Click the Delete icon  next to the payment type that is to be deleted.

A message opens stating that the selected payment type was deleted.

3. Click OK.

The message closes. The field is deleted immediately from the Payment Types page.
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Managing Global Emails
A global email is an email that is accessible for any Send Email function in EMS Regics (for 
example, emailing participants from the Manage Participants page). Managing global emails 
consists of adding new global emails to your EMS Regics system, editing global emails, and 
deleting global emails.

To add a global email

1. On the EMS Regics menu, click Admin > Configuration > Emails.

The Emails page opens. This page lists all the global emails (alphabetically by name) 
that have been configured for your EMS Regics system.

Figure 4-10: Emails page

2. Click Add.

The Send Email dialog box opens. You use this options on this dialog box to configure 
the global email. See Figure 4-11 on page 119.
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Figure 4-11: Send Email dialog box

3. Add the information for the global email.

4. Click Save.

The Send Email dialog box closes. A message opens indicating that the email was saved.

5. Click OK.

The message closes. The newly added global email message is displayed on the Emails 
page.

Table 4-3: Send Email dialog box fields

Field Description

Name The name of the global email. You can use this name to identify the 
appropriate global email when sending an email to an event or survey 
participants. See “To send an email to one or more participants” on page 100.

Subject The subject for the global email. This value that you enter here is displayed by 
default in the Subject line when the email is sent to an event or survey 
participant, but a user can always modify this value.

Message You can use the formatting options on the Message toolbar to format the body 
of the email as needed (for example, colors, font, and so on). You can also 
select specific Participant fields and specific Event fields that are to be 
included in the email.

Note: If you include Participant Fields and/or Event Fields in the message, 
then the message is personalized based on the values in the selected 
fields for each message recipient. A user can always modify any or all 
of the message as needed.
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To edit a global email

1. On the EMS Regics menu, click Admin > Configuration > Emails.

The Emails page opens. This page lists all the global emails (alphabetically by name) 
that have been configured for your EMS Regics system. See Figure 4-10 on page 118.

2. Select the global email that you are editing, and then click Edit.

The Send Email dialog box opens. The dialog box displays all the editable information 
(name, subject, and message) for the email.

3. Edit the email as needed.

4. Click Save.

The Send Email dialog box closes. A message opens indicating that the email was saved.

5. Click OK.

The message closes. The global email message is displayed on the Emails page.

To delete a global email

When you delete a global email, it is simply deleted them from the list of available global 
emails. The deletion does not affect any global emails that have been previously sent to 
participants.

1. On the EMS Regics menu, click Admin > Configuration > Emails.

The Emails page opens. This dialog box lists all the global emails (alphabetically by 
name) that have been configured for your EMS Regics system. See Figure 4-10 on page 
118.

Table 4-4: Send Email dialog box fields

Field Description

Name The name of the global email. You can use this name to identify the 
appropriate global email when sending an email to an event or survey 
participants. See “To send an email to one or more participants” on page 
100.

Subject The subject for the global email. This value that you enter here is 
displayed by default in the Subject line when the email is sent to an 
event or survey participant, but a user can always modify this value.

Message You can use the formatting options on the Message toolbar to format the 
body of the email as needed (for example, colors, font, and so on). You 
can also select specific Participant fields and specific Event fields that 
are to be included in the email.

Note: If you include Participant Fields and/or Event Fields in the 
message, then the message is personalized based on the values 
in the selected fields for each message recipient. A user can 
always modify any or all of the message as needed.
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2. Select the global email that you are deleting, and then click Delete.

A message opens, asking you if you are sure that you want to delete the email.

3. Click OK.

The message closes. A second message opens, indicating that the selected email was 
deleted.

4. Click OK.

The second message closes. The global email is deleted from the global emails list.
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Managing Global Confirmation Messages
A global confirmation message is a confirmation message that is accessible for any 
confirmation message function in EMS Regics (for example, configuring confirmation 
messages). Managing global confirmation messages consists of adding new global 
confirmation messages to your EMS Regics system, editing global confirmation messages, 
and deleting global confirmation messages.

To add a global confirmation message

1. On the EMS Regics menu, click Admin > Configuration > Confirmation Messages.

The Messages page opens. This page lists all the global confirmation messages 
(alphabetically by name) that have been configured for your EMS Regics system.

Figure 4-12: Messages page

2. Click Add.

The Message dialog box opens. You use this options on this dialog box to configure the 
global confirmation message. See Figure 4-13 on page 123.

Global confirmation messages include both confirmation messages and 
cancellation messages.
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Figure 4-13: Message dialog box

3. Add the information for the global confirmation message.

4. Click Save.

The Message dialog box closes. A message opens indicating that the message was saved.

Table 4-5: Message dialog box fields

Field Description

Name The name of the global confirmation message. You can use this name to identify 
the appropriate global confirmation message when configuring a confirmation 
message for an event or survey. See “To configure a new confirmation 
message” on page 60.

Status The participant status (Pending, Confirmed, Cancelled, or Wait list) which 
determines when this confirmation message is automatically generated and sent 
to a participant. 

Sender Email The email address that is displayed by default in the Sender field for the 
confirmation message. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender Email 
address.

Sender Name The name of the sender that is displayed by default in the in the Sender field for 
the confirmation message. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender Email 
address.

Subject The text that is displayed in the Subject line for the confirmation message.

Message Use the formatting options at the top of the Message field to format the body 
(font, color, size, and so on) of the confirmation message.
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5. Click OK.

The message closes. The newly added global confirmation message is displayed on the 
Messages page.

6. Optionally, to review the message and verify that you are satisfied with it before it is sent 
to participants, click Email me.

The message is sent to the email address that you used to log in to EMS Regics.

To edit a global confirmation message

1. On the EMS Regics menu, click Admin > Configuration > Confirmation Messages.

The Messages page opens. This page lists all the global confirmation messages 
(alphabetically by name) that have been configured for your EMS Regics system. See 
Figure 4-12 on page 122.

2. Select the global confirmation message that you are editing, and then click Edit.

The Message dialog box opens. The dialog box displays all the editable information for 
the message.

3. Click Save.

The Message dialog box closes. A message opens indicating that the message was saved.

Table 4-6: Message dialog box fields

Field Description

Name The name of the global confirmation message. You can use this name to 
identify the appropriate global confirmation message when configuring a 
confirmation message for an event or survey. See “To configure a new 
confirmation message” on page 60.

Status The participant status (Pending, Confirmed, Cancelled, or Wait list) 
which determines when this confirmation message is automatically 
generated and sent to a participant. 

Sender Email The email address that is displayed by default in the Sender field for the 
confirmation message. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender 
Email address.

Sender Name The name of the sender that is displayed by default in the in the Sender 
field for the confirmation message. You can edit this value.

Note: Your EMS Regics administrator configures the default Sender 
Email address.

Subject The text that is displayed in the Subject line for the confirmation 
message.

Message Use the formatting options at the top of the Message field to format the 
body (font, color, size, and so on) of the confirmation message.
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4. Click OK.

The message closes. The global confirmation message is displayed on the Messages 
page.

5. Optionally, to review the message and verify that you are satisfied with it before it is sent 
to participants, click Email me.

The message is sent to the email address that you used to log in to EMS Regics.

To delete a global confirmation message

When you delete a global confirmation message, it is simply deleted them from the list of 
available global confirmation messages. The deletion does not affect any global messages 
that have been previously sent to participants.

1. On the EMS Regics menu, click Admin > Configuration > Confirmation Messages.

The Messages page opens. This dialog box lists all the global confirmation message 
(alphabetically by name) that have been configured for your EMS Regics system. See 
Figure 4-10 on page 118.

2. Select the global confirmation message that you are deleting, and then click Delete.

A message opens, asking you if you are sure that you want to delete the message.

3. Click OK.

The message closes. A second message opens, indicating that the selected global 
confirmation message was deleted.

4. Click OK.

The second message closes. The global confirmation message is deleted from the global 
emails list.
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Managing Secondary Statuses
When a participant submits a registration for an event or cancels a registration, a primary 
status (Confirmed, Cancelled, Pending, or Wait List) is automatically assigned to the 
participant. A secondary status is a status that you can manually assign to an event 
participant. You typically use secondary statuses to manage your event participants in a way 
that best meets your organization’s business needs. For example, if a confirmed registrant 
does not attend the event, you might want to assign a secondary status of “No Show” to the 
registrant. After tabulating all the confirmed registrants that were a No Show for the event, 
you might be better able to carry out planning before you host the event again (for example, 
the number of available souvenirs, the amount of available food, and so on.) Managing 
secondary statuses consists of adding new secondary statuses, editing secondary statuses, 
and deleting secondary statuses.

To add a secondary status

1. On the EMS Regics menu, click Admin > Configuration > Secondary Statuses.

The Secondary Statuses page opens. This page lists all the secondary statuses that have 
been configured for your EMS Regics system.

Figure 4-14: Secondary Statuses page

2. Click Add.

The Secondary Status dialog box opens.

Figure 4-15: Secondary Status dialog box
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3. Enter a name for the secondary status, and then click Save.

The Secondary Status dialog box closes. The secondary status is displayed on the 
Secondary Statuses page.

To edit a secondary status

1. On the EMS Regics menu, click Admin > Configuration > Secondary Statuses.

The Secondary Statuses page opens. This page lists all the secondary statuses that have 
been configured for your EMS Regics system. See Figure 4-14 on page 126.

2. Select that secondary status that you are editing, and then click Edit.

The Secondary Status dialog box opens. The name of the selected secondary status is 
displayed in it.

3. Edit the name for the secondary status, and then click Save.

A message opens, indicating that the secondary status was saved.

4. Click OK.

The message closes. The secondary status is displayed on the Secondary Statuses page.

To delete a secondary status

When you delete a secondary status, the status is deleted not only from the list of available 
secondary statuses, but also from registrants to whom it was already assigned. Also, the 
history of this deletion is not displayed on the History tab for the registrant’s record, so make 
very sure that you want to delete the secondary status before you do so.

1. On the EMS Regics menu, click Admin > Configuration > Secondary Statuses.

The Secondary Statuses page opens. This page lists all the secondary statuses that have 
been configured for your EMS Regics system. See Figure 4-14 on page 126.

2. Select that secondary status that you are deleting, and then click Delete.

A message opens, asking you if you are sure that you want to delete the secondary status.

3. Click OK.

A second message opens, indicating that the secondary status was deleted.

4. Click OK.

The second message closes. The secondary status is deleted from the Secondary Statuses 
page.
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Managing Item Level Tax Rates
You can add the different item level tax rates (for example, city tax, state tax, and so on) that 
your organization requires for processing payments in your EMS Regics system. You can 
also edit a tax rate and you can delete a tax rate. Tax rates on previous registrations remain 
the same if you edit or delete these rates. Going forward, only new registrations are affected.

To add a tax rate

1. On the EMS Regics menu, click Admin > Configuration > Tax Rates.

The Tax Rates page opens. This page lists all the tax rates that have been configured for 
your EMS Regics system.

Figure 4-16: Tax Rates page

2. Click Add.

The Tax Rate dialog box opens.

Figure 4-17: Tax Rate dialog box
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3. Enter the name for the tax rate and the numerical value for the rate.

4. Click Save.

The Tax Rate dialog box closes. The tax rate is displayed on the Tax Rates page.

To edit a tax rate

1. On the EMS Regics menu, click Admin > Configuration > Tax Rates.

The Tax Rates page opens. This page lists all the tax rates that have been configured for 
your EMS Regics system. See Figure 4-16 on page 128.

2. Select that tax rate that you are editing, and then click Edit.

The Tax Rate dialog box opens. The name of the selected tax rate is displayed in it.

3. Edit the name for the secondary status, and then click Save.

A message opens, indicating that the secondary status was saved.

4. Click OK.

The message closes. The secondary status is displayed on the Secondary Statuses page.

To delete a tax rate

1. On the EMS Regics menu, click Admin > Configuration > Tax Rates.

The Tax Rates page opens. This page lists all the tax rates that have been configured for 
your EMS Regics system. See Figure 4-16 on page 128.

2. Select that tax rate that you are deleting, and then click Delete.

A message opens, asking you if you are sure that you want to delete the tax rate.

3. Click OK.

A second message opens, indicating that the tax rate was deleted.

4. Click OK.

The second message closes. The tax rate is deleted from the Tax Rates page.

Decimal points are allowed. Percentage is assumed for the tax rate.
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EMS Regics System 
Administration - General 
Administration

This chapter details the general administrative functions that are available in EMS Regics.

This chapter covers the following topics:

• “Managing EMS Regics System Parameters” on page 133.

• “Managing your EMS Regics License” on page 136.

• “Managing Help Text in EMS Regics” on page 137.

• “Searching for Transactions” on page 139.
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Managing EMS Regics System Parameters
System parameters are global settings that affect the basic functioning of EMS Regics for all 
users. As the EMS Regics administrator user, you are responsible for managing the values 
for the EMS Regics system parameters. You can also view the history for a system 
parameter.

To manage EMS Regics system parameters

1. On the EMS Regics menu, click > Admin > System Administration > Parameters.

The System Parameters page opens. This page lists all of the system parameters for your 
EMS Regics system (grouped by area) and the current value for each parameter.

Figure 5-1:  System Parameters page

2. Optionally, to display only those system parameters for a specific area, open the Areas 
dropdown list and select the area.

3. Do any or all of the following as needed:

• To print a list of parameters for the parameter area that is currently displayed (the 
Parameters report), click Print.

The Parameters report opens. The report lists the parameter area, the parameter 
name, and the current value for the parameter. The report has options for printing the 
onscreen preview, exporting the list fields to a file such as a PDF, and so on. See 
Figure 5-2 on page 134.

For a complete list of system parameters (definition and value) grouped by Area, 
see Appendix A, “EMS Regics System Parameters,” on page 181.
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Figure 5-2:  Parameters report example

• To change the value for a system parameter, click the parameter Description to open 
the Update Parameter dialog box. In the Description field, change the value for the 
parameter, and then click Save.

Figure 5-3:  Update Parameter dialog box
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• To view the history for a parameter, open the History tab. The History tab is a 
view-only tab that shows the original creation date of the parameter and the name of 
the user who created the parameter. The tab also shows last date that the parameter 
was edited as well as the name of the user who last edited the parameter.

Figure 5-4:  History tab
EMS Regics User’s Manual 135



Chapter 5
EMS Regics System Administration - General Administration
Managing your EMS Regics License
As the EMS Regics administrator, you can manage the license information for you 
organization’s implementation of EMS Regics. You can view your current license 
information, and if needed, upload a new license file, and/or make manual a verification call 
to dea.com to validate the license.

To manage your EMS Regics license

1. On the EMS Regics menu, click > Admin > System Administration > License.

The EMS Regics License page opens. The page displays all the information for your 
current EMS Regics license as well as critical verification information.

Figure 5-5:  EMS Regics License page

2. Optionally, do one or more of the following as needed:

• To upload a new license file, click Browse to open the Choose File to Upload dialog 
box and browse to and select the new license file. After you select the file, click 
Upload to load the file for your EMS Regics application.

• To manually validate your EMS Regics license, click Upload Verification Call. A 
call is made to dea.com to validate the license.

Typically, verification calls are made to dea.com to validate your EMS Regics 
license; however, in the event that you need to manually validate the license, for 
example, the connection to dea.com was interrupted for an extended period of 
time, then you can use the Make Verification Call function to validate the license.
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Managing Help Text in EMS Regics
As an EMS Regics administrator user, you can customize messages in key areas of your 
system that provide organizational specific information or hints to your users about using 
EMS Regics. For example, you might want to place help text above on the Change Password 
page that explains your organization’s password rules. You have two options for managing 
help text in EMS Regics—from the Help Text function on the Admin menu, or by clicking 
an Edit link that appears next to the help text on an EMS Regics page.

To manage help text in EMS Regics

1. On the EMS Regics menu, click > Admin > System Administration > Help Text.

The Help Text page opens.

Figure 5-6:  Help Text page

1. To customize the help text in your EMS Regics system, do one or both of the following:

• Click the Lookup Key link for the help text to open the page for editing the help text.

Figure 5-7:  Page that opens for editing help text in a selected area of EMS Regics
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• Toggle Enable Help Text. The message “Help Text Mode is now enabled” opens 
(click OK to close the message), and the toggle now reads “Disable Help Text Edit. 

Figure 5-8:  Enable Help Text toggle - Help Text Mode enabled

An Edit link is now displayed next to all the Help Text records for the current EMS 
Regics session. Click this Edit link to open the page for editing the help text at the 
location at which it appears in your EMS Regics system. 

Figure 5-9:  Editing the help text at the location at which it appears in your EMS Regics 
system

2. Optionally, to disable Help Text mode, toggle Disable Help Text Edit.

The message “Help Text Mode is now disabled” opens (click OK to close the message), 
and the toggle now reads “Enable Help Text Edit.

Figure 5-10: Help Text Mode Enabled

Click this Edit link to open the page for editing the help text at the 
location at which it appears in your EMS Regics system
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Searching for Transactions
You can the Transactions browser to search for specific transactions based on various criteria 
such as the transaction date, the transaction ID, the authorization code, the first and/or last 
name of the event registrant and/or the payment type.

To search for transactions

1. On the EMS Regics menu, click Transactions.

The Transactions page opens.

Figure 5-11: Transactions page

2. Enter your search options.

• Leave all search fields blank to search for all transactions of all types by all 
participants in your EMS Regics system.

• Start Date/End Date:

• Start Date only—Search for all credit card transactions from the Start Date up to 
and including the current day's date.

• End Date only—Search for all credit card transactions up to and including the 
End Date.

• Start Date and End Date—Search for all credit card transactions that occurred 
within the specified date range.

• First Name, Last Name, and Email—Your search is limited to the exact order of the 
characters in the string, but the string can appear anywhere in the search results. The 
search is not case-sensitive. For example, if you enter Son in the Last Name field, 
then search results can include Johnson, Sondeheim, and so on.

• Auth Code/Transaction ID—Your search is limited to the exact order of the 
characters in the string, and the search results must begin with the string. For 
example, if you enter 65 in the Auth Code field, then search results can include 
65001, 65002, but not 00165.
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• Payment type—Select a payment type from the available options.

3. Click Search.

A list of participants who meet all the search criteria that you specified is displayed on 
the Credit Card Transactions page.

Figure 5-12: Transactions page with search results

4. Optionally, do any of the following as needed:

• Rearrange the search results to better suit your working needs.

• Select one or more transactions, and then click Mark as Received.

• Export the list of transactions:

1. On the Format dropdown list, select the format to which you are exporting the 
list of participants. (PDF is the default value.)

  

If a specific payment type is not available, contact your EMS Regics administrator. 
For more information about configuring payment types, see “Managing Payment 
Types” on page 112.

See “An EMS Regics Browser Page” on page 22.

To select all transactions that are currently displayed, select the blank check box 
next to the Registration ID column header. If you have multiple pages of 
transactions to select, you must repeat this step on each page.

If you inadvertently mark Received for a participant who still owes a payment, 
then you must clear the Billed option on the Accounting tab of the Edit Registrant 
dialog box for the registrant. See “Managing Participants” on page 91.
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2. Click Export.

A message opens, asking you if you want to open the file or save the file.

3. Do one of the following:

• To view the file online (you cannot rename or save the file), click Open.

• To save the file to a location of your choice (you can also rename the file), 
click Save.
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This chapter details the security functions that are available in EMS Regics.

This chapter covers the following topics:

• “Overview of Users in EMS Regics” on page 145.

• “Managing Users in EMS Regics” on page 146.

• “Managing Groups in EMS Regics” on page 156.

• “Resetting a Participant’s Password” on page 161.
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Overview of Users in EMS Regics
An Administrator user for EMS Regics has full site privileges and full access to all the event 
registrations forms and surveys that have been defined in your organization’s EMS Regics 
system. A Standard user in EMS Regics does not have full site privileges in EMS Regics; 
however, a Standard user does have varying degrees of access to event registration forms and 
surveys depending on how the user account has been set up, including privileges for creating 
new event forms or surveys, managing participants, and delegating events to other standard 
users. A Standard user account can also be assigned to a group.

Delegating accounts

Standard user accounts can also be set up so that Standard users can create their own events 
or surveys in your organization’s EMS Regics system. Standard users can edit any and all 
aspects of the event registration form or surveys that they create, including the participant 
information. Standard users with permission to create their own events/surveys can also 
grant event access to other standard users. These delegate Standard user accounts can have 
the same varying degrees of access—Run Reports, Manage Attendees, and/or Edit—to event 
registration forms and surveys as any other Standard user account.

Groups

Instead of setting up individual user accounts and assigning access on a user by user basis, a 
user account can be assigned to a group. Event access is assigned at the group level so that 
all members of a group have the same access. Frequently, groups are used for delegate 
accounts to make the management of certain events easier. For example, if you are the 
Marketing Director for your organization, your Administrator user can create a Marketing 
group in your organization’s EMS Regics system and set you up as a Standard user with the 
ability to create your own events and surveys. You can then assign the members of your 
marketing department to the Marketing group in EMS Regics, and all members of this group 
can manage the marketing events that you create on your behalf.
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Managing Users in EMS Regics
Managing users in EMS Regics consists of adding new user accounts, editing user 
information, and deleting user accounts. You can also print a list of all active or inactive 
users in your EMS Regics system (the User report).

To add a user account

1. On the EMS Regics menu, click Admin > Security > Users.

The Users page opens. The Active tab is the open tab. This tab lists all of the currently 
active user accounts (Administrator and Standard) for your organization’s EMS Regics 
system.

Figure 6-1:  Users page, Active tab

2. Under Actions, click Add.

The Add User page opens. This page contains a series of tabs for adding the detailed 
information for the new user account. 

Figure 6-2:  Add User page
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3. Add the information for the new user account. See:

• “Details tab” below.

• “Events tab” on page 149.

• “Groups tab” on page 151.

4. Click Save.

The Add User dialog box closes. You return to the Users page. After you create the user 
account, the user is automatically sent an email with the account password.

Details tab

Figure 6-3:  Add User page, Details tab

1. Do one of the following:

• To create a user account for a user who already exists in your organization’s Global 
Address List:

• Click the Lookup Users icon  to open the User Lookup dialog box.

Figure 6-4:  User Lookup dialog box

This step list the tabs in the order in which they appear on the Add User page; 
however, you can enter the information for the user account in any order that 
meets your business needs.
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• In the User Name field, enter the criteria by which to search for a user, and then click 
Go. To search for all users, leave the User Name field blank.

• Click the User Name for the appropriate user to close the User Lookup dialog 
box and return to the Details tab. The tab is populated with the information for 
the selected user.

• To create a new user account, at a minimum, you must enter the Full Name and 
Email for the user. (Phone, Fax, and External References are optional.)

2. Under Account Type, select Standard or Administrator. 

• If you select Administrator, then you can continue adding information for the new 
account as needed. See:

• “Events tab” on page 149.

• “Groups tab” on page 151.

• If you select Standard, then, go to Step 3.

3. Do one or both of the following:

• If the Standard user is to be able to create new events and also grant access to these 
events to other standard users, then select Create new events. (See “Delegating 
accounts” on page 145.) Leave this option blank if the user is to have access to only 
those pre-defined events that you specify for the account.

• If the Standard user is to be able to view and process transactions associated with 
events that they create, or events that you specified for the user’s account, then select 
Run/View Transactions; otherwise, leave this option blank.

4. Continue adding the information for the user as needed; otherwise, if you are done with 
configuration, click Save.

The Add User dialog box closes. You return to the Users page. After you create the user 
account, the user is automatically sent an email with the account password.

Your search is limited to the exact order of the characters in the string, but the 
string can appear anywhere in the search results and the search is not 
case-sensitive. For example, if you enter And, search results can include Andy 
Wells, Deandra Smith, and so on. 

For standard users to be able to grant access to their events to new standard user 
accounts, then the EMS Regics system parameter “Allow Event Owner to create a 
new user account” must also be enabled. See Appendix A, “EMS Regics System 
Parameters - Security,” on page 186.

If you enable the Run/View Transactions option for a Standard user account, then 
a Transactions option is displayed on the EMS Regics menu after the user logs in. 
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Events tab

By definition, an Administrator user has full site privileges and full access to all of the event 
registrations forms and surveys that have been defined in your organization’s EMS Regics 
system. Therefore, the Events tab is available only when you are adding or modifying a 
Standard user account. You use the options on this tab to specify the pre-defined events 
(registration forms or surveys) to which the user can have access. You can also specify the 
different options that are to be available to the user on a per event basis.

Figure 6-5:  Add User page, Events tab

1. Click Add.

The Event Processes dialog box opens. You use this to dialog box to select the 
pre-defined events to which the user can have access.

Figure 6-6:  Event Processes dialog box

2. In the Events dropdown list, scroll to and select an event to which the user is to have 
access. See Figure 6-7 on page 150.

You can also search for the event and the results are displayed as you enter the 
search string. For example, entering Ca in the Events field results in the events 
that begin with or contain “Ca” being displayed in the Event Processes dialog 
box. 
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Figure 6-7:  Automatically displayed search results in the Events Processes dialog box

3. Clear the process options—Run Reports, Edit, and/or Manage Attendees—that are not to 
be available to the user for the selected event. 

4. Click Save.

The selected event is displayed on the Events tab.

By default, all three options are selected for an event. You can always edit the 
selected options for a user account event, and you can always remove an event 
from a user account. See Table 6-1 on page 150.

Table 6-1: Standard User event permissions

Access Description

Run Reports With Run Reports access, a Standard user has access to all the reports 
(Common and Financial) for specific registration forms or surveys that are 
defined in your organization’s EMS Regics system. The Standard user can 
also view a list of participants for an event or survey, and change a 
participant’s status, send email to a user, or both. The Standard user, 
however, does not have any other type of access to the registration form or 

survey. The Event Snapshot report icon  is displayed next to the events 

or surveys to which the Standard user has Run Reports access.

Manage Attendees With Manage Attendees access, a Standard user has full editing access to 
the participant information for specific registration forms or surveys that are 
defined in your organization’s EMS Regics system. The Participants icon 

 is displayed next to the events or surveys to which the Standard user 

has Manage Attendees access.

Edit With Edit access, a Standard user has full editing access to specific 
registration forms or surveys that are defined in your organization’s EMS 
Regics system. The Standard user can edit any and all aspects of the event 
registration form or survey, with the exception the participant information. 
(To be able to edit the participant information for these events, the Manage 

Attendees permission must also be assigned to the user.) The Edit icon  

is displayed is displayed next to the events or surveys to which the Standard 
user has Edit access.
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5. Repeat Step 2 through Step 4 until you have added all of the needed events to the user 
account.

6. Continue adding the information for the user as needed; otherwise, if you are done with 
configuration, click Save.

The Add User dialog box closes. You return to the Users page. After you create the user 
account, the user is automatically sent an email with the account password.

Groups tab

Figure 6-8:  Add User page, Groups tab

1. Do one of the following:

• To search for all groups that are available in your EMS Regics system, leave the 
Find field blank, and then click Go. 

A list of all available groups is displayed in the Groups pane.

• To search for a specific group to which to add the user, enter you search criteria in 
the Find field, and then click Go. 

A list of all available groups that meet your search criteria is displayed in the Groups 
pane.

Only Administrator users can add, modify, or delete groups in EMS Regics. 
Standard users, however, who have the ability to create their own events can 
assign users to groups. 

Your search is limited to the exact order of the characters in the string, but the 
string can appear anywhere in the search results and the search is not 
case-sensitive. For example, if you enter cam, search results can include Campus 
Tours, Camtasia Learning Group, and Digital Camera Basics.
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2. In the Groups pane, select the group, or CTRL-click to select the multiple groups to 

which you are adding the user, and then click the Add button  to add the groups to 
the Selected pane.

3. Continue adding the information for the user as needed; otherwise, if you are done with 
configuration, click Save.

The Add User dialog box closes. You return to the Users page. After you create the user 
account, the user is automatically sent an email with the account password.

To edit a user account

1. On the EMS Regics menu, click Admin > Security > Users.

The Users page opens. The Active tab is the open tab. This tab lists all of the currently 
active user accounts (Administrator and Standard) for your organization’s EMS Regics 
system. See Figure 6-1 on page 146.

2. Select the user account that you are editing.

3. Under Actions, click Edit.

The Add User page opens. This page contains a series of tabs for editing the information 
for the user account. See Figure 6-2 on page 146.

4. Optionally, before you modify the user account, open the History tab to view a history of 
the user account.

The History tab is a view-only tab that shows the original creation date of the user 
account and the name of the user who created the account. The tab also shows last date 
that the account was edited as well as the name of the user who last edited the account. 
See Figure 6-9 on page 153.

Only Administrator users can create, modify, and delete groups in EMS Regics. If 
you cannot find a specific group, contact your EMS Regics administrator. 

To remove a group from a user account, in the Selected pane, select the group, or 
CTRL-click to select the multiple groups from which you are removing the user, 

and then click the Remove button  to return the groups to the Groups pane.

If the list is long, you can also search for a user. In the User Name field or the 
email field, enter your search criteria and then click Go. Your search is limited to 
the exact order of the characters in the string, but the string can appear anywhere 
in the search results and the search is not case-sensitive. For example, if you enter 
And in the Name field, search results can include Andy Wells, Deandra Smith, and 
so on. 
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Figure 6-9:  History tab for a user

5. Modify the information for the Standard user as appropriate.

See:

• “Details tab” on page 147.

• “Events tab” on page 149.

• “Groups tab” on page 151.

6. Click Save.

To delete a user account

You can delete a user account only if it is an inactive account and if the user is not referenced 
by any event. If the account that you are deleting is referenced by any events, then you must 
first select a different user to assign to these events before you can delete the user account.

1. On the EMS Regics menu, click Admin > Security > Users.

The Users page opens. The Active tab is the open tab. This tab lists all of the currently 
active user accounts (Administrator and Standard) for your organization’s EMS Regics 
system. See Figure 6-1 on page 146.

2. Open the Inactive tab.

Figure 6-10: Users page, Inactive tab

If you are creating a delegate account, then you should modify the information 
only on the Events tab or the Groups tab.
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3. Select the user account that you are deleting.

4. Under Actions, click Delete.

Two results are possible:

• If the user account is not referenced by any events, then a dialog box opens, asking 
you if you sure that you want to delete the selected user. Click OK in this dialog box 
to delete the user account.

• If the user account is referenced by any event, then a Delete User dialog box opens. 
This dialog box states the user is referenced by <x> number of events and informs 
you that you must select a different user for these events before you can delete the 
selected user account.

Figure 6-11: Delete User dialog box

5. Select a different user, and then click OK. 

The Delete User dialog box closes and the selected user account is deleted.

To print a list of users

You can print a list of all active users in your EMS Regics system, or you can print a list of 
all inactive users.

1. On the EMS Regics menu, click Admin > Security > Users.

The Users page opens. The Active tab is the open tab. This tab lists all of the currently 
active user accounts (Administrator and Standard) for your organization’s EMS Regics 
system. See Figure 6-1 on page 146.

2. If needed, open the Inactive tab. See Figure 6-10 on page 153.

3. Click Print.

The User report opens. The report lists all the active or inactive users in your EMS 
Regics system. The report lists the following information for the users—the user name, 
the user’s email address, the user Account Type (Standard or Administrator), and the 
user’s phone number. It also lists any groups of which the user is a member as well as the 
event permissions for the group. See Figure 6-12 on page 155.
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Figure 6-12: User report example

The User report has options for printing the onscreen preview, exporting the list 
fields to a file such as a PDF, and so on. Place your mouse pointer on a toolbar 
button to open tooltip text for the button.
EMS Regics User’s Manual 155



Chapter 6
EMS Regics System Administration - Security
Managing Groups in EMS Regics
As an Administrator user, instead of assigning event access to user accounts on a user by user 
basis, you can create a group that has the event access defined at the group level. All users 
who are assigned to a group then have the same event access privileges. You can also edit the 
information for a group and delete a group. You can also print a list of all the groups in your 
EMS Regics system (the Group report).

To add a group

1. On the EMS Regics menu, click Admin > Security > Groups.

The Groups page opens. This page lists all of the available groups in your EMS Regics 
system.

Figure 6-13: Groups page 

2. Click Add.

The Group dialog box opens. You use the options on this dialog box to name the group 
and to specify the events to which the new group is to have access. See Figure 6-14 on 
page 157.

Only Administrator users can add, modify, or delete groups in EMS Regics. A 
Standard user, however, who has the ability to create their own events, can assign 
users to groups. 
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Figure 6-14: Group dialog box

3. In the Description field, enter the name for the new group.

4. Open the Events tab, and on this tab, click Add.

The Event Processes dialog box opens. You use this to dialog box to select the 
pre-defined events to which the group can have access.

Figure 6-15: Event Processes dialog box

5. In the Events dropdown list, scroll to and select an event to which the group is to have 
access.

You can also search for the event and the results are displayed as you enter the 
search string. For example, entering Ca in the Events field results in the events 
that begin with or contain “Ca” being displayed in the Event Processes dialog 
box. See Figure 6-16 on page 158.
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Figure 6-16: Automatically displayed search results in the Events Processes dialog box

6. Clear the process options—Run Reports, Edit, and/or Manage Attendees—that are not to 
be available to the user for the selected event. 

7. Click Save.

The selected event is displayed on the Events tab.

  

By default, all three options are selected for an event. You can always edit the 
selected options for a group account event, and you can always remove an event 
from a group account.

Table 6-2: Group event permissions

Access Description

Run Reports With Run Reports access, a Standard user has access to only the participant 
information for specific registration forms or surveys that are defined in your 
organization’s EMS Regics system. The Standard user can view a list of 
participants for an event or survey, and change a registrant’s status, send 
email to a user, or both. The Standard user, however, does not have any 
other type of access to the registration form or survey. The Participants icon 

 is displayed next to the events or surveys to which the Standard user 

has Run Reports access.

Manage Attendees With Manage Attendees access, a Standard user has full editing access to 
the participant information for specific registration forms or surveys that are 
defined in your organization’s EMS Regics system. 

Edit With Edit access, a Standard user has full editing access to specific 
registration forms or surveys that are defined in your organization’s EMS 
Regics system. The Standard user can edit any and all aspects of the event 
registration form or survey, with the exception the participant information. (To 
be able to edit the participant information for these events, the Manage 

Attendees permission must also be assigned to the user.) The Edit icon  is 

displayed is displayed next to the events or surveys to which the Standard 
user has Edit access.
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8. Repeat Step 5 through Step 7 until you have added all of the needed events to the group 
account.

To edit a group

When you edit a group, you can also view the history for the group.

1. On the Admin menu, click Security > Groups.

The Groups page opens. This page lists all of the available groups in your EMS Regics 
system. See Figure 6-13 on page 156.

2. Select the group for which you are modifying the information, and then click Edit.

The Group dialog box opens. See Figure 6-14 on page 157.

3. Edit any and all information for the group:

• In the Description field, edit the group name.

• Open the Events tab to display the list of all events to which the group has access

• To remove an event, select the event, click Remove, and then click Save.

• To change the group privileges for a specific event, select the event, and then 
click Edit. In the Event Processes dialog box, select or clear the reporting and 
editing options as needed, and then click Save.

4. In the Group dialog box, click Save.

5. Optionally, to view the history of the group, open the History tab.

The History tab is a view-only tab that shows the original creation date of the group and 
the name of the user who created the group. The tab also shows last date that the group 
was edited as well as the name of the user who last edited the group.

Figure 6-17: History tab for a group
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To delete a group

1. On the Admin menu, click Security > Groups.

The Groups page opens. This page lists all of the available groups in your EMS Regics 
system. See Figure 6-13 on page 156.

2. Select the group that you are deleting, and then click Delete.

A message opens, asking you if you are sure that you want to delete the group.

3. Click OK.

The message closes, and a second message opens, indicating that the group was deleted.

4. Click OK.

The second message closes. The group is deleted and is no longer displayed in the 
Groups dialog box.

To print a list of groups

1. On the Admin menu, click Security > Groups.

The Groups page opens. This page lists all of the available groups in your EMS Regics 
system. See Figure 6-13 on page 156.

2. Click Print.

The Group report opens. The report lists all the groups in your EMS Regics system. The 
report lists the group name and event permissions for each group. 

Figure 6-18: Group report example

The Group report has options for printing the onscreen preview, exporting the list 
fields to a file such as a PDF, and so on. Place your mouse pointer on a toolbar 
button to open tooltip text for the button.
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Resetting a Participant’s Password
After a participant registers for an event, or submits a survey, a Reset Password option is 
always available from the event registration form or survey. When a participant clicks this 
link, a new password is automatically generated and sent in an email to the participant’s 
email address that is on record in EMS Regics. An option to manually reset a participant’s 
password is also available in EMS Regics.

To manually reset a participant’s password

1. On the Admin menu, click Security > Participant Password Reset.

The Reset Participant Password page opens.

Figure 6-19: Reset Participant Password page

2. In the Email field, enter the participant’s email address.

3. In the New Password field, enter the participant’s new password.

4. Click Reset.

You must manually provide the new password to the user. 

If you need to look up the participant’s email address, you can search for the 
participant’s record. See “Managing Participants” on page 91.

EMS Regics does not place any restrictions on the password that you enter. It is up 
to you to adhere to any password restrictions that your organization might have.
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EMS Regics contains two different categories of standard reports—Common and Finance—
to assist you in monitoring and maintaining your organization’s event registration forms and/
or surveys, and if applicable financial transactions. You can also create custom reports that 
define custom criteria for searching for information in your organization’s EMS Regics 
database. 

This chapter covers the following topics:

• “Generating Standard Reports” on page 164.

• “Generating and Managing Custom Reports” on page 168.
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Generating Standard Reports
EMS Regics contains two different categories of standard reports—Common and Finance—
to assist you in monitoring and maintaining your organization’s event registration forms and/
or surveys, and if applicable financial transactions. You generate these reports for an event 
registration form or survey from the Event Dashboard. You also have the option of exporting 
these standard reports to a file. Finally, you can also create a custom URL for several of these 
standard reports and then forward this URL to any user so that you can share real-time EMS 
Regics data with the user.

To generate a standard report

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab.

Figure 7-1:  Event Dashboard, Reports tab (for an event)

  

If you are running EMS Regics in Internet Explorer 8, you must enable the 
following setting: Tools -> Internet Options -> Security -> Custom Level -> 
Downloads -> Automatic prompting for file downloads. Enabling this setting 
ensures that you can generate reports or export a file to a list.
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3. Click the link for the report that is being generated and/or exported.

Every standard report has options for printing the onscreen preview, exporting the 
list fields to a file such as a PDF, and so on. Place your mouse pointer on a 
toolbar button to open tooltip text for the button.

Report Description

Common Reports

Event Snapshot

Survey Snapshot

• To generate a Snapshot report of up to and including the current 
day’s date, leave Add date range blank, and then click Run.

• To run a Snapshot report for a specific date range, click Add a date 
range, and then enter a Start date and an End date, and then click 
Run.

Event Snapshot Export

Survey Snapshot Export

A message opens, asking you if you want to open or save the 
EventSnapshotDetail or SurveySnapshotDetail file. (The file is exported 
in a Microsoft Excel (.xls) format.) Do one of the following:

• To view the file online, click Open. (You can rename and save the file 
to a location of your choice after you open it.)

• To save the file to a location of your choice (you can also rename the 
file), click Save.

Event Detail

Survey Detail

A message opens, asking you if you want to open or save the 
EventDetailReport or SurveyDetailReport file. (The file is exported in a 
comma-separated values (.csv) format.) Do one of the following:

• To view the file online, click Open. (You can rename and save the file 
to a location of your choice after you open it.)

• To save the file to a location of your choice (you can also rename the 
file), click Save.

Address List Available only for events. An onscreen report is generated that displays 
the address information (physical and email) for the event registrants. 

Wait List Available only for events. An onscreen report is generated that displays 
all the potential participants who have been placed on the Wait List for 
the selected event.

Incompletes An onscreen report is generated that lists the all the participants 
(grouped by Registration ID) who have not completed their registrations 
and/or surveys for an event.

Financial Reports

Transactions report Available only for events. An onscreen report is generated that displays 
all the transactions, including credit card transactions, that have taken 
place for all the event registrants. The report has options for printing the 
onscreen preview, exporting the list fields to a file such as a PDF, and so 
on. Place your mouse pointer on a toolbar button to open tooltip text for 
the button.

Credit Card 
Transactions report

Available only for events. An onscreen report is generated that displays 
specifically all the credit card transactions that have taken place for the 
all the event registrants. 
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To share standard reports with a user

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab.

Figure 7-2:  Event Dashboard, Reports tab (for an event)

3. Next to the report that is to be shared, click the Share icon . 

A Share Report dialog box opens.

Figure 7-3:  Share Report dialog box
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4. Click Share this report to create a report link that can be shared with others.

The Share tab is updated with three fields:

• Report Link—The automatically generated URL for the report. You can forward this 
URL to any user so that you can share real-time EMS Regics data with the user.

• Report Password—Optional. If you want to limit the online access to this shared 
report, then you can enter a report password. You must remember to forward this 
password as well as the URL for a user to have access to the report.

• Report Format—The format in which the report is displayed when the user opens the 
report. By default, HTML is selected, but you can select a different format.

5. Do one of the following:

• Click Save to save these changes and close the Share Report dialog box. You remain 
on the Reports tab.

• Click Apply to save the report without closing the Share Report dialog box. You can 
make any changes for sharing the report as needed before saving these changes.

• Click Close to close the Share Report dialog box without saving any changes and 
return to the Reports tab.

Optionally, you can click View next to this link to open an onscreen preview of the 
custom report. The report that you see when you click View is identical to the 
report that a user sees when they open the report from this URL. The report has 
options for printing the onscreen preview, exporting the list fields to a file such as 
a PDF, and so on. Place your mouse pointer on a toolbar button to open tooltip 
text for the button.
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Generating and Managing Custom Reports
A Custom Reports function is available from the Reports tab on the Event Dashboard. You 
can use this function to create custom reports for retrieving user-defined information from 
your EMS Regics database for a specific event registration form or survey. You can create a 
new custom report or you can create a custom by copying an existing custom report and 
editing the copied report as needed. When you create a custom report, you can name and 
save the report so that you can generate the report at any time that you choose, and after 
generating the report, you can export the report to a file and/or print the report. You can also 
edit a custom report and delete a custom report, and you can view the history for a custom 
report. Finally, you can also create a custom URL for any custom report and then forward 
this URL to any user so that you can share real-time EMS Regics data with the user.

To create a new custom report

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab.

Figure 7-4:  Event Dashboard, Reports tab (for an event)
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3. Click Add Custom Report.

The Query Builder dialog box opens. The Details tab is the active tab. You use the 
options on this dialog box to name and define the custom report. 

Figure 7-5:  Query Builder dialog box, Details tab

4. Enter the needed information for the query. See:

• “Details tab” on page 170.

• “Display Fields tab” on page 171.

• “Filter tab” on page 172.

• “Sort tab” on page 173.

• “Results tab” on page 174.

• “Share tab” on page 175.

5. Click Save.

The Query Builder dialog box closes and the custom report is saved. The report is 
displayed on the Reports tab under the Custom Reports option. Options are also 
displayed for editing the report, copying the report, deleting the report, and sharing the 
report with users. 

This step list the tabs in the order in which they appear on the Query Builder 
dialog box; however, you can enter the information for the custom report in any 
order that meets your business needs.
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Details tab

Figure 7-6:  Query Builder dialog box, Details tab

1. In the Description field, enter a name or title that describes the report.

2. Optionally, select Return First ‘xx’ number of records, and then enter the maximum 
number of records that this report is to return.

3. Optionally, open the Results tab, and then click Preview to run the report immediately 
and view the results on the tab. 

4. Do one of the following:

• Click Apply to save the custom report without closing the Query Builder dialog box. 
You can then continue with any other configuration for the custom report as needed.

• Click Save to close the Query Builder dialog box and save the custom report. The 
report is displayed on the Reports tab under the Custom Reports option. You can run 
this report at any later date when needed. Options are also displayed for editing the 
report, copying the report, deleting the report, and sharing the report with users. 

If you do not select this option, then all participant records that meet the report 
criteria are returned by the report.

The results tab is an EMS Browser page. See “An EMS Regics Browser Page” on 
page 22.
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Display Fields tab

Figure 7-7:  Query Builder dialog box, Display Fields tab

1. Open the Display Fields tab, and then select the field, or CTRL-click to select the 
multiple fields that are to be displayed in the report, and then click the Add button (>) to 
move the selected fields to the Selected list.

2. The fields are displayed in the report in the order in which they are listed in the Selected 
list. Optionally, to change the order of the fields, select a field and then click Move Up/
Move Down as needed.

3. Optionally, open the Results tab, and then click Preview to run the report immediately 
and view the results on the tab. 

  

If you are copying an existing report, then when the Display Fields tab opens, the 
Selected list is already populated with a list of fields. You can select one or more of 
these fields, and then click the Remove button (<) or Remove All button (<<)to 
move any or all of these fields back to the Available list.

The Results tab is an EMS Browser page. See “An EMS Regics Browser Page” on 
page 22.
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4. Do one of the following:

• Click Apply to save the custom report without closing the Query Builder dialog box. 
You can then continue with any other configuration for the custom report as needed.

• Click Save to close the Query Builder dialog box and save the custom report. The 
report is displayed on the Reports tab under the Custom Reports option. You can run 
this report at any later date when needed. Options are also displayed for editing the 
report, copying the report, deleting the report, and sharing the report with users. 

Filter tab

Figure 7-8:  Query Builder dialog box, Filter tab

1. Open the Filter Fields tab, and then select each field that is to define the report and click 
the Add button (>) to move the field to the Filter list.

For each field that you select, a dialog box opens in which you must specify the allowed 
values for the field. After you specify the values and click OK, the dialog box closes, and 
the selected field is moved to the Filter list.

If you are copying an existing report, then when the Filter tab opens, the Filter list 
is already populated. You can select one or more of these fields and then click the 
Remove button (<) or the Remove All button (<<) to move any or all of these 
fields back to the Available list. If you want to use the same Filter fields in the 
“new” report, but with different values, you cannot change the values directly. You 
must move the appropriate fields back to the Available list, then select the fields 
again to change their values.
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2. Optionally, open the Results tab, and then click Preview to run the report immediately 
and view the results on the tab. 

3. Do one of the following:

• Click Apply to save the custom report without closing the Query Builder dialog box. 
You can then continue with any other configuration for the custom report as needed.

• Click Save to close the Query Builder dialog box and save the custom report. The 
report is displayed on the Reports tab under the Custom Reports option. You can run 
this report at any later date when needed. Options are also displayed for editing the 
report, copying the report, deleting the report, and sharing the report with users.

Sort tab

Figure 7-9:  Query Builder dialog box, Sort tab

1. Open the Sort tab, select the field or CTRL-click to select the multiple fields by which 
the report results are to be sorted, and then click the Move button (>) to move the fields 
to the Selected list.

The Results tab is an EMS Browser page. See “An EMS Regics Browser Page” on 
page 22.

If you are copying an existing report, then when the Sort tab opens, the Sort list is 
already populated. You can select one or more of these fields and then click the 
Remove button (<) or the Remove All button (<<) to move any or all of these 
fields back to the Available list. 
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2. The order in which the fields are displayed in the Selected list indicates the order by 
which the report results will be sorted. Optionally, to change the order of the fields, 
select a field and then click Move Up/Move Down as needed.

3. Optionally, open the Results tab, and then click Preview to run the report immediately 
and view the results on the tab. 

4. Do one of the following:

• Click Apply to save the custom report without closing the Query Builder dialog box. 
You can then continue with any other configuration for the custom report as needed.

• Click Save to close the Query Builder dialog box and save the custom report. The 
report is displayed on the Reports tab under the Custom Reports option. You can run 
this report at any later date when needed. Options are also displayed for editing the 
report, copying the report, deleting the report, and sharing the report with users. 

Results tab

Figure 7-10: Query Builder dialog box, Results tab

When you are creating or editing a custom report, before you save the report, you can open 
the Results tab, and then click Preview to run the report immediately and view the results on 
the tab. You can determine if the results meet your expectations, and them modify the report 
accordingly before you save report. 

The Results tab is an EMS Browser page. See “An EMS Regics Browser Page” on 
page 22.
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Share tab

You use the options on the Share tab create a custom URL for the custom report. You can 
then forward this URL to any user so that you can share real-time EMS Regics data with the 
user.

Figure 7-11: Query Builder dialog box, Share tab

1. Click Share this Report.

The Share tab is updated with three fields:

• Report Link—The automatically generated URL for the report. You can forward this 
URL to any user so that you can share real-time EMS Regics data with the user.

• Report Password—Optional. If you want to limit the online access to this shared 
report, then you can enter a report password. You must remember to forward this 
password as well as the URL for a user to have access to the report.

The Results tab is an EMS Browser page. See “An EMS Regics Browser Page” on 
page 22.

Optionally, you can click View next to this link to open an onscreen preview of the 
custom report. The report that you see when you click View is identical to the 
report that a user sees when they open the report from this URL. The report has 
options for printing the onscreen preview, exporting the list fields to a file such as 
a PDF, and so on. Place your mouse pointer on a toolbar button to open tooltip 
text for the button.
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• Report Format—The format in which the report is displayed when the user opens the 
report. 

2. Optionally, open the Results tab, and then click Preview to run the report immediately 
and view the results on the tab. 

3. Do one of the following:

• Click Apply to save the custom report without closing the Query Builder dialog box. 
You can then continue with any other configuration for the custom report as needed.

• Click Save to close the Query Builder dialog box and save the custom report. The 
report is displayed on the Reports tab under the Custom Reports option. You can run 
this report at any later date when needed. Options are also displayed for editing the 
report, copying the report, deleting the report, and sharing the report with users.

To create a custom report by copying an existing report

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab. See Figure 7-4 on page 168.

3. Click the Copy icon  next to the custom report that you are copying.

A message opens, indicating that the selected report was copied.

4. Click OK.

The message closes. A copy of the copied custom report is displayed under the Custom 
Reports section. The copied report is indicated with the word “Copy” at the end of the 
title.

Figure 7-12: Copied custom report 

  

The results tab is an EMS Browser page. See “An EMS Regics Browser Page” on 
page 22.
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5. Click the Edit icon  next to the copied custom report.

The Query Builder dialog box opens. The Details tab is the active tab. See Figure 7-5 on 
page 169.

6. Edit the copied report as necessary. See:

• “Details tab” on page 170.

• “Display Fields tab” on page 171.

• “Filter tab” on page 172.

• “Sort tab” on page 173.

• “Results tab” on page 174.

• “Share tab” on page 175.

7. Click Save.

The Query Builder dialog box closes and the custom report is saved. The report is 
displayed on the Reports tab under the Custom Reports option. Options are also 
displayed for editing the report, copying the report, deleting the report, and sharing the 
report with users. 

To edit a custom report

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab. See Figure 7-4 on page 168.

3. Click the Edit icon  next to the custom report that you are editing.

The Query Builder dialog box opens. The Details tab is the active tab. See Figure 7-5 on 
page 169.

4. Edit the report as necessary. See:

• “Details tab” on page 170.

• “Display Fields tab” on page 171.

• “Filter tab” on page 172.

This step list the tabs in the order in which they appear on the Query Builder 
dialog box; however, you can enter the information for the custom report in any 
order that meets your business needs.
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• “Sort tab” on page 173.

• “Results tab” on page 174.

• “Share tab” on page 175.

5. Click Save.

The Query Builder dialog box closes and the custom report is saved. The report is 
displayed on the Reports tab under the Custom Reports option. Options are also 
displayed for editing the report, copying the report, deleting the report, and sharing the 
report with users. 

To delete a custom report

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab. See Figure 7-4 on page 168.

3. Click the Delete icon  next to the custom report that you are deleting.

A message opens, asking you if you are sure that you want to delete the report.

4. Click OK.

The message closes. A second message opens, indicating that the selected report was 
deleted.

5. Click OK.

The second message closes. The custom report is deleted from the Event Dashboard.

To view the history for a custom report

The History tab is available for a custom report only if the report has been saved.

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab. See Figure 7-4 on page 168.

  

This step list the tabs in the order in which they appear on the Query Builder 
dialog box; however, you can enter the information for the custom report in any 
order that meets your business needs.
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3. Click the Edit icon  that is next the saved custom report for which you are viewing the 

history.

The Query Builder dialog box opens. The Details tab is the active tab. See Figure 7-5 on 
page 169.

4. Open the History tab.

The History tab is a view-only tab that shows the original creation date of the custom 
report and the name of the user who created the custom report. The tab also shows last 
date that the report was edited as well as the name of the user who last edited the report.

Figure 7-13: Query Builder dialog box, History tab

To run, export, and/or print a custom report

1. Search for and open the event registration form or survey in the Event Dashboard. 

See “To search for an event registration form or survey and open it in the Event 
Dashboard” on page 78.

2. Open the Reports tab. See Figure 7-4 on page 168.

3. Click the title of the custom report that you are generating

The report is generated and displayed onscreen in a standalone Results tab. See Figure 7-
14 on page 180.
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Chapter 7
EMS Regics Reports
Figure 7-14: Custom report example

4. Optionally, do one or both of the following:

• To export the report to a file, on the Format dropdown list, select the file format 
Available options are PDF (the default value), XLS (the Microsoft Excel format), 
and CSV (comma separated values format).

A message opens, asking you if you want to open or save the ReportGrid file. Do 
one of the following:

• To view the file online, click Open. (You can rename and save the file to a 
location of your choice after you open it.)

• To save the file to a location of your choice (you can also rename the file), click 
Save.

• To print the report, click Print. An onscreen preview of the report is generated.

The Results tab is an EMS Browser page. See “An EMS Regics Browser Page” on 
page 22.

The report has options for printing the onscreen preview, exporting the list fields 
to a file such as a PDF, and so on. Place your mouse pointer on a toolbar button 
to open tooltip text for the button.
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Appendix A
EMS Regics System Parameters

This appendix details the EMS Regics system parameters that you can configure as the EMS 
Regics administrator.

This appendix covers the following topics:

• “EMS Regics System Parameters - Email” on page 182.

• “EMS Regics System Parameters - Labels” on page 183.

• “EMS Regics System Parameters - Portal Authentication” on page 184.

• “EMS Regics System Parameters - Registration Form” on page 185.

• “EMS Regics System Parameters - Security” on page 186.

• “EMS Regics System Parameters - System Configuration” on page 187.
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EMS Regics System Parameters - Email

Parameter Description

Account to Use for 
Sending Email

The email account that is used to send emails to the participants in your EMS 
Regics system.

Email Address of 
Sender

The email address that is displayed by default in the Sender Email field for 
any email that you send to participants in your EMS Regics system. A user 
can always edit this value.

Name of Email 
Sender

The name of that is displayed by default in the Sender Name field for any 
email that you send to participants in your EMS Regics system. A user can 
always edit this value.

Password of Email 
Account

The password that is used to access the Account to Use for Sending Email.

SMTP - Use SSL Indicates whether to use a Secure Socket Layer port with the SMTP email 
account.

SMTP server The server for the SMTP email account.

SMTP server port 
number

The number of the port that the SMPT server uses.
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EMS Regics System Parameters - Labels

Parameter Description

Checkout Label on 
an event/survey 
form

The default label for the Checkout section for an event registration form or 
survey.

Confirmation Label 
on event/survey 
form

The default label for the Confirmation section for an event registration form or 
survey.

Personal 
Information Label 
on event/survey 
form

The default label for the Personal Information section for an event 
registration form or survey.

Secondary Status 
Plural Label

System label defined for secondary statuses.

Secondary Status 
Singular Label

System label defined for secondary statuses.
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EMS Regics System Parameters - Portal 
Authentication

Parameter Description

Portal 
Authentication 
Cookie Key

The value for the portal authentication cookie.

Portal 
Authentication 
Method

The method by which portal authentication for your EMS Regics system is 
carried out.

Portal 
Authentication 
Variable

The variable that is used for the selected portal authentication method.
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EMS Regics System Parameters - Registration 
Form

Parameter Description

Terms of Use Link 
(Enter url to your 
terms of use)

The URL to your organization’s Privacy policy. The link to your organization’s 
Privacy policy is displayed as “Privacy Policy” on the first page of an online 
event registration form.

Confirmation Label 
on event/survey 
form

The URL to your organization’s Terms of Use policy. The link to your 
organization’s Terms of Use policy is displayed as “Terms of Use” on the first 
page of an online event registration form.
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EMS Regics System Parameters - Security

Parameter Description

Allow Event Owner to create a new 
user account

Indicates whether standard users should be able to create other 
standard user accounts (delegate standard user accounts).

Enable CAPTCHA. This feature 
requires users to enter a distorted 
phrase before submitting an event.

Enables additional protection from malicious programs that 
automatically submit registration forms or surveys by having a user enter 
a specific distorted phrase on the registration form/ survey that must be 
verified before the registration form/survey can be submitted.

Force user to change password when 
creating a user account (Set to no if you 
are exclusively using LDAP for 
authentication)

If set to Yes, then after a user logs in for the first time to EMS Regics, the 
user is required to change his/her login password before continuing in 
the system.

Minimum Length Required for a New 
Password

The minimum number of characters required for a new participant 
password.

Number of attempts to login before a 
user is locked out. (Zero = unlimited)

The number of attempts for a user to log in to an event registration form 
or survey before the user is locked out. Access to the form or survey 
must be reset by the EMS Regics system administrator. 

The minimum number of 
non- alphanumeric characters for a 
user password.

The minimum number of special characters required for a participant 
password. An underscore is a considered to be a special character, but 
a space is not.
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EMS Regics System Parameters - System 
Configuration

Parameter Description

Application Timezone Sets the time zone for the application to the indicated value

Max results displayed before pagination 
is used

The maximum number of results to be returned by a search on a single 
page. After this number is exceeded, pagination is implemented.
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Introduction 

EMS Regics can integrate with various third party hosted payment page providers to provide a secure, 
seamless and low-cost option for organizations wanting to add credit card payment options to their 
registration process without having to worry about credit card security and Payment Card Industry (PCI) 
rules.  Because credit card data isn’t actually captured, transmitted or stored by our application, EMS 
Regics is not classified as a payment application under PCI rules and exempt from PCI compliance 
standards.  Third party hosted payment page solutions, however, are categorized as payment 
applications and service providers marketing this capability are held to the PCI standards.  These 
providers are required to host their solutions within PCI compliant data centers and their applications 
must be PA-DSS certified. 
 
This document outlines the EMS Regics credit card payment process, options and configuration steps. 
 
 

Customer Support 

Unlimited toll-free customer support is available to EMS users who have a current Annual Service 
Agreement (ASA).  If you are unable to resolve a problem or answer a question by reading the EMS 
documentation, contact us at: 
 

Email:  support@dea.com 
Web:  www.dea.com 
Phone:  (800) 288-4565 
Fax:  (303) 796-7429 

 
Important:  Please note that support for the EMS Regics credit card processing module extends only to 
the configuration of the EMS Regics specific items below.  Please consult your merchant/service provider 
for any questions or issues related to the setup or support of your provider’s hosted payment page option. 

 

Currently Supported 3rd Party Hosted Payment Page Service 
Providers 

 Authorize.Net 

 Intuit 

 PayPal*** 

 TouchNet*** 

 Nelnet 

 MercuryNet*** 

 Official Payments 

 TransFirst 

 CASHNet 
 

***Refunds supported 
 
Please contact your Dean Evans and Associates LLC. Account Manager to inquire about integration 
possibilities with other service providers.  Note:  Your service provider must have a hosted payment 
page option in order for EMS Regics to integrate with their solution. 
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How it Works 
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Configuring Gateway Connections and Payment Types 

Adding a Gateway Connection 

 
Important:  Before beginning the installation process, please verify that you have all of the information 
necessary to configure your gateway connection.  Please see the Gateway Setup Information section for 
a screenshot of required fields. 
 

1. Install EMS Regics.  Please refer to EMS Regics Installation Instructions for information on how 
to install EMS Regics. 

2. Log into EMS Regics with an administrator level account. 
3. Enter the following URL into your browser: 

 
http://[ServerName]/EMSRegics/GatewayConfiguration.aspx  
(replace [ServerName] with the name of your web server) 
 
The following screen will appear: 
 

 
 

4. Click Add Gateway. 
5. Select your gateway from the Choose Gateway dropdown. 
6. Complete the required information.  Please see the Gateway Setup Information section for a 

screenshot of required fields. 
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7. Click the Make Verification Call button.  If an error is encountered please contact your 
merchant/service provider’s support department. 

8. Click the Save button. 
 

Adding a Payment Type 

1. Within EMS Regics, go to Admin > Configuration > Payment Type. 
2. Click Add Payment Type.  The following screen will appear: 

 

 
 

3. Enter a Title. 
4. Select the Credit Card checkbox. 
5. In the Gateways dropdown, select the Gateway configured in the previous section. 
6. Click the Create button. 

 
Once configured, valid payment types are available when creating new events in EMS Regics.  Please 
see the EMS Regics User Guide for information on how to create an event. 
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Gateway Setup Information 

Authorize.Net 

 
Server Integration Method information: 
https://developer.authorize.net/integration/fifteenminutes/#hosted 
 
EMS Regics Gateway Setup 

 
 

Intuit 

 
Hosted Pay Page information: 
http://qbsdk.developer.intuit.com/0085_QuickBooks_Windows_SDK/qbms/0010_Hosted_PayPage 
 
EMS Regics Gateway Setup 

 
 

PayPal 

 
Adaptive Payments information: 
https://cms.paypal.com/us/cgi-bin/?cmd=_render-content&content_ID=developer/e_howto_api_APIntro 

https://developer.authorize.net/integration/fifteenminutes/#hosted
http://qbsdk.developer.intuit.com/0085_QuickBooks_Windows_SDK/qbms/0010_Hosted_PayPage
https://cms.paypal.com/us/cgi-bin/?cmd=_render-content&content_ID=developer/e_howto_api_APIntro
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EMS Regics Gateway Setup 

 

 

TouchNet 

 
EMS Regics Gateway Setup 

 
 



Credit Card Payment Processing in EMS Regics 

 2014 Dean Evans and Associates LLC.                                                                                   CONFIDENTIAL 10 

NelNet 

 
EMS Regics Gateway Setup 

 
 

MercuryNet 

 
EMS Regics Gateway Setup 

 

 

Official Payments 

 
EMS Regics Gateway Setup 
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TransFirst 

 
Transaction Express information: 
https://www.transfirst.com/products/online-solutions/payment-gateway.htm 
 
 
EMS Regics Gateway Setup 

 

 

CASHNet 

 
EMS Regics Gateway Setup 

https://www.transfirst.com/products/online-solutions/payment-gateway.htm
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Sage Payment Solutions – Express Pay 

 
EMS Regics Gateway Setup 

 
 
Setting up the Sage Payment Gateway 
1. Login to the Virtual Terminal: 
https://www.sagepayments.net/virtualterminal/frmLogin.aspx 
 
2. Go to Shopping Cart>Configuration then select the configuration tab. Paste the below link (with the 
proper domain) into the Approved URL, Declined URL and Post Back URL. 
https://www.yourdomain.com/Regics/Confirmation.aspx?GatewayType=13 
 

https://www.sagepayments.net/virtualterminal/frmLogin.aspx
https://www.yourdomain.com/RegicsS/Confirmation.aspx?GatewayType=13
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Introduction 


EMS Regics can integrate with various third party hosted payment page providers to provide a secure, 
seamless and low-cost option for organizations wanting to add credit card payment options to their 
registration process without having to worry about credit card security and Payment Card Industry (PCI) 
rules.  Because credit card data isn’t actually captured, transmitted or stored by our application, EMS 
Regics is not classified as a payment application under PCI rules and exempt from PCI compliance 
standards.  Third party hosted payment page solutions, however, are categorized as payment 
applications and service providers marketing this capability are held to the PCI standards.  These 
providers are required to host their solutions within PCI compliant data centers and their applications 
must be PA-DSS certified. 
 
This document outlines the EMS Regics credit card payment process, options and configuration steps. 
 
 


Customer Support 


Unlimited toll-free customer support is available to EMS users who have a current Annual Service 
Agreement (ASA).  If you are unable to resolve a problem or answer a question by reading the EMS 
documentation, contact us at: 
 


Email:  support@dea.com 
Web:  www.dea.com 
Phone:  (800) 288-4565 
Fax:  (303) 796-7429 


 
Important:  Please note that support for the EMS Regics credit card processing module extends only to 
the configuration of the EMS Regics specific items below.  Please consult your merchant/service provider 
for any questions or issues related to the setup or support of your provider’s hosted payment page option. 


 


Currently Supported 3rd Party Hosted Payment Page Service 
Providers 


 Authorize.Net 


 Intuit 


 PayPal*** 


 TouchNet*** 


 Nelnet 


 MercuryNet*** 


 Official Payments 


 TransFirst 


 CASHNet 
 


***Refunds supported 
 
Please contact your Dean Evans and Associates LLC. Account Manager to inquire about integration 
possibilities with other service providers.  Note:  Your service provider must have a hosted payment 
page option in order for EMS Regics to integrate with their solution. 
 
 







Credit Card Payment Processing in EMS Regics 


 2014 Dean Evans and Associates LLC.                                                                                   CONFIDENTIAL 5 


How it Works 
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Configuring Gateway Connections and Payment Types 


Adding a Gateway Connection 


 
Important:  Before beginning the installation process, please verify that you have all of the information 
necessary to configure your gateway connection.  Please see the Gateway Setup Information section for 
a screenshot of required fields. 
 


1. Install EMS Regics.  Please refer to EMS Regics Installation Instructions for information on how 
to install EMS Regics. 


2. Log into EMS Regics with an administrator level account. 
3. Enter the following URL into your browser: 


 
http://[ServerName]/EMSRegics/GatewayConfiguration.aspx  
(replace [ServerName] with the name of your web server) 
 
The following screen will appear: 
 


 
 


4. Click Add Gateway. 
5. Select your gateway from the Choose Gateway dropdown. 
6. Complete the required information.  Please see the Gateway Setup Information section for a 


screenshot of required fields. 







Credit Card Payment Processing in EMS Regics 


 2014 Dean Evans and Associates LLC.                                                                                   CONFIDENTIAL 7 


7. Click the Make Verification Call button.  If an error is encountered please contact your 
merchant/service provider’s support department. 


8. Click the Save button. 
 


Adding a Payment Type 


1. Within EMS Regics, go to Admin > Configuration > Payment Type. 
2. Click Add Payment Type.  The following screen will appear: 


 


 
 


3. Enter a Title. 
4. Select the Credit Card checkbox. 
5. In the Gateways dropdown, select the Gateway configured in the previous section. 
6. Click the Create button. 


 
Once configured, valid payment types are available when creating new events in EMS Regics.  Please 
see the EMS Regics User Guide for information on how to create an event. 
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Gateway Setup Information 


Authorize.Net 


 
Server Integration Method information: 
https://developer.authorize.net/integration/fifteenminutes/#hosted 
 
EMS Regics Gateway Setup 


 
 


Intuit 


 
Hosted Pay Page information: 
http://qbsdk.developer.intuit.com/0085_QuickBooks_Windows_SDK/qbms/0010_Hosted_PayPage 
 
EMS Regics Gateway Setup 


 
 


PayPal 


 
Adaptive Payments information: 
https://cms.paypal.com/us/cgi-bin/?cmd=_render-content&content_ID=developer/e_howto_api_APIntro 



https://developer.authorize.net/integration/fifteenminutes/#hosted

http://qbsdk.developer.intuit.com/0085_QuickBooks_Windows_SDK/qbms/0010_Hosted_PayPage

https://cms.paypal.com/us/cgi-bin/?cmd=_render-content&content_ID=developer/e_howto_api_APIntro
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EMS Regics Gateway Setup 


 


 


TouchNet 


 
EMS Regics Gateway Setup 
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NelNet 


 
EMS Regics Gateway Setup 


 
 


MercuryNet 


 
EMS Regics Gateway Setup 


 


 


Official Payments 


 
EMS Regics Gateway Setup 
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TransFirst 


 
Transaction Express information: 
https://www.transfirst.com/products/online-solutions/payment-gateway.htm 
 
 
EMS Regics Gateway Setup 


 


 


CASHNet 


 
EMS Regics Gateway Setup 



https://www.transfirst.com/products/online-solutions/payment-gateway.htm
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Sage Payment Solutions – Express Pay 


 
EMS Regics Gateway Setup 


 
 
Setting up the Sage Payment Gateway 
1. Login to the Virtual Terminal: 
https://www.sagepayments.net/virtualterminal/frmLogin.aspx 
 
2. Go to Shopping Cart>Configuration then select the configuration tab. Paste the below link (with the 
proper domain) into the Approved URL, Declined URL and Post Back URL. 
https://www.yourdomain.com/Regics/Confirmation.aspx?GatewayType=13 
 



https://www.sagepayments.net/virtualterminal/frmLogin.aspx

https://www.yourdomain.com/RegicsS/Confirmation.aspx?GatewayType=13
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